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1 About instruction manual 

This instruction manual will help you use the Hal E-bank. We will introduce to 
you capabilities of the application one step at a time, which means that the 
only thing to do is to follow the written instructions. Special warning windows 
contain information which warns you about possible errors or irregularities. 

* All application functionalities are described in this manual. Functionalities 
that bank does not support are invisible or inactive in the application. 

The information given in this manual may contain technical or printing 
errors. The information in this manual will change from time to time. These 
changes will be incorporated into new versions of this manual. Certain 
functions described in this manual may be different depending on version of 
the application installed on your personal computer. 

1.1 Conventions and terminology used in this 
instruction manual 

This section introduces you to the terms and conventions that will be 
used. 

Hal E-Bank system represents electronic bank solution for domestic and 
foreign payments. System is intended for legal entities (corporate) and 
individual entities (persons). 

Hal E-Bank/Corporate is a multi-user version, intended for 
simultaneous use on many computers connected into a local area network. 

 Hal E-Bank/Personal is a single-user version, intended for use on one 
computer. 

Name Hal E-Bank will be used in the following text for electronic bank, 
for any of the versions of program explained previously. 

Personal number or PIN (Personal Identification Number) is a code of 
the security smart card (similar to the number you use with the ATM 
machine). Personal number is checked every time by the smart card. Smart 
card is used when accessing the program, sending payment orders to the 
bank, receiving documents from the bank, upgrading program or changing 
PIN. 

Username and password for dialup connection are data needed to 
establish connection to bank server using dialup modem. 

For easier reading, text, menu options, commands and names of files are 
written using different styles. Menu options are written in bold, italic letters 
(for example File). To perform some action sometimes you need to select 
several options from menu successively. N that case options are options are 
written in a row, separated by commas. If, for example, this is written: 
File, Exit, which means that in menu File, option Exit should be selected. 
In this given example, you would finish the work with the program. When 
selecting the entry that you would like to send, export, import, etc., you can 
use certain shortcuts on the computer’s keyboard. They are given in the 
manual between the symbols < and > and are written in bold letters. For 
example: <Ctrl>, <Shift>, <Enter>, <F1>, <Home>. Names of files are 
written in font of the regular typewriter with equal letter width, for 
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example: addressbook.txt  

Important parts of the text are written in bold letters. 
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2 Introduction 

2.1 Electronic bank 
Under the term electronic bank, we define the way of using the bank 

services, which you as a client can perform from your work or home, 
without the help of a bank employee, at any time of day (24 hours a day, 
365 days a year). Other e-banking terms are: banking over distances or 
tele-banking, banking from home (home banking), banking from job 
(corporate banking). This shows that there are many types of electronic 
banking, and each is tailored to certain segment of bank clients. 

By using your computer in electronic bank, you can carry out different 
types of non-cash transactions (for example:transfers between your 
accounts, payment of bills, viewing the balance of your accounts, get 
reports about entries  for defined period, send messages to the bank and 
receive information from the bank). All the payment orders that you are 
sending from your computer are sent directly to the bank's central 
system, without any mediation by bank clerks. A bank clerk is informed 
only about those requests of the client, that demand additional decisions 
or human processing. Sent payment orders are processed immediately or 
as soon as it is possible. Bank processing can also reject a payment 
order. In this case the user receives information about rejection of the 
transaction. 

Transactions in electronic bank are carried out using public 
communication media; therefore the protection of transactions is of 
essential importance. We have achieved protection thoroughness in 
electronic banking by 

• Making the information secret and available only to those whom 
they are intended for; the information is encrypted on the side of 
the sender and decrypted on the receiver's side;  

• Including the option of establishing the authenticity and integrity of 
information by using digital signatures; 

• Checking the source of information - by checking if the sender is 
who he or she claims to be. By establishing the authenticity we 
exclude the possibility of sender denying sending the information or 
hiding them. Authenticity is established by authorized certificates of 
the bank clients; 

• Proper protection to eliminate intrusion into bank’s central system. 

Proper protection is of key importance in electronic banking, since it has 
to be trusted by the clients (users) and by the banks as well. Modern 
electronic banks use the protection that utilizes the protection by cards 
with a microchip – smart card – loaded with the operating system for 
information protection 

Protection used by Hal E-Bank is based on supreme technology of user 
identification and digital signing of transactions based on public key 
infrastructure (PKI) system developed by the Swedish company 
SmartTrust. 
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2.2 What is Hal E-Bank? 
Hal E-Bank is a modern software product for support of electronic 

banking for owners of bank accounts. It can be used by all who have 
transaction accounts open with the bank. With Hal E-bank, you can carry 
out all the non-cash transactions, that you would normally do using the 
bank counter, from job or from home at any time. Hal E-Bank knows no 
limits, as bank counters do, which are opened only daily during operating 
hours 

Hal E-Bank program is installed on your personal computer. For using 
it, you also need a smart card and a reader for it, and means of 
connecting to the bank’s network. Connection to the bank’s network 
entry point can be established via the Internet. Protection of information 
in the Hal E-Bank is based on smart cards, which is currently the highest 
means of protection in commercial world. It was developed especially for 
protection of information, encryption and authorization. Smart card 
reader connects to the personal computer. Working with a smart card 
and a reader is similar to working with a bank card and an ATM machine. 
To enter the Hal E-Bank program, you insert your smart card into the 
reader and enter your personal number (similar to password on the ATM 
machine). Checking the identity, encryption of information and electronic 
signing of all the orders is done in the smart card itself. If you loose the 
card, and if the dishonest finder tries to use it, the card will automatically 
destroy itself after three failed attempts of entering the personal number. 
Authorization of user, electronic signature and integrity of information of 
all the orders that you send to the bank, are based on principle of pair 
RSA keys (private and public), and encryption of information on principle 
of standardized algorithm DES. 

2.3 What Hal E-Bank offers? 
Hal E-Bank offers you a series of possibilities to lower your costs, 

improve productivity and simplify connecting between financial programs. 

With Hal E-Bank you can: 

• check the balance on your accounts, 

• send payment orders (also orders with payment cue in advance), 

• check transactions on the accounts by different time periods, 

• exchange electronic messages with the bank, 

• link preparation the orders with address book of authorized 
beneficiaries and their accounts, 

• keep permanent payment orders for multiple use (regular or similar 
monthly payments), 

• receive payment orders from the file which contain payment orders  
in a standardized format,  

• exchange orders and transaction items with your accounting 
programs, 
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• print out information from saved payments, transaction items and 
other documents …, 

• etc….
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3 Basic requirements 

For using Hal E-Bank you need to have:  

• an appropriate PC with Windows 95/98/ME/NT/2000/XP or 2003 
operating system installed, 

• smart card reader, 

• a connection with the bank’s server, 

• Hal E-Bank installation CD, 

• bank agreement and 

• smart card. 

Let take a closer look to each item listed above. 

3.1 PC 

3.1.1 Hal E-Bank/Personal  

Recommended PC configuration: 

• Pentium processor (Pentium II recommended), 

• Recommended amount of RAM memory depends on operating 
system installed on PC:  

- for Windows 95/98/ME: minimum 32 MB recommended 
64MB, 

- for Windows NT: minimum 64 MB recommended 128 MB, 
processor speed minimum 200 MHz , 

- for Windows 2000/2003 or XP: minimum 128 MB 
recommended 256 MB, 

• minimum 200MB available space on hard disk, 

• CD-ROM unit, or access to the CD-ROM unit in the local area 
network, 

• communication ports depend on your smart card reader: 

- at least one available USB port for USB reader, 
- at least one available serial port (9-pin, or 25-pin with 25-

pin to 9-pin adapter) for COM reader with own power 
supply, 

- in addition to COM reader with own power supply, it's 
needed at least one PS/2 or DIN port with two additional 
adapters (DIN to PS/2 and PS/2 to DIN) for COM reader 
with power supply through PS/2 or DIN port 

- at least one available PCMCIA port for PCMCIA reader. 

• Installed OS Windows 95/98/ME/NT (version 4.0 with Service 
Pack 3 or higher)/2000/XP/2003, with support for TCP/IP 
protocol. For using dial-up connection, modem has to be installed 
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and support for "Dial-Up Networking". RAS service (»Remote 
Access Service«) has to be installed for Windows 
NT/2000/XP/2003. If installation process needs administrative 
rights you have to supply administrative account or to contact 
system administrator. 

• Installed Microsoft Internet Explorer 5 or higher, 

• Installed Acrobate Reader or Adobe Acrobate 5 or higher 

3.1.2 Hal E-Bank/Corporate 

Hal E-Bank/Corporate program is intended for use by legal 
entities, which perform payment operations on many local area 
network computers. Hal-user version of Corporate E-Bank program 
works in client/server mode which requires joint database, usually 
installed on a server, a separate, more powerful computer. The server 
must have the database server IBM DB2 UDB Workgroup Edition 
(version for work groups) installed. Workstations are required to have 
IBM DB2 Client Application installed and software of proper 
configuration. Installation of software IBM DB2 and configuring the 
connection should be performed by a skilled technician 

Workstations have to meet the requirements stated in Section Hal e-
Bank/Personal. In addition, they also have to be connected to a local 
area network (Support for TCP/IP communication protocol needs to be 
installed and properly configured). At least one of the computers has 
to have CD-ROM drive for installing software. 

SERVER'S HARDWARE AND SOFTWARE REQUIREMENTS: 

Version of IBM DB2 database demands requirements for OS as 
follows: 

• IBM DB2 ver. 6.1, 

 Windows NT 4.0, installed SP3 or higher 

 Windows 2000 

 Windows XP 

• IBM DB2 ver. 7.2, 

 Windows NT 4.0, installed SP4 or higher 

 Windows 2000 

 Windows XP 

 Windows 2003 

• IBM DB2 ver. 8.2, 

 Windows NT 4.0, installed SP6a or higher 

 Windows 2000, for Windows Terminal Server installed SP2 
or higher 

 Windows XP 

 Windows 2003. 
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• TCP/IP protocol support, 

• Constant IP address within the local network (not DHCP), 

• Server's name must contain only letters and/or numbers 
(alphanumerical), 

• Requested disk space for IBM DB2 installation: 

 - IBM DB2 ver. 6.1, at least 120 Mb 

 - IBM DB2 ver. 7.2, at least 200 Mb 

 - IBM DB2 ver. 8.2, at least 500 Mb 

Needed disk space is hard to define because possibility of receiving 
files. Aproxx requirements: 5000 transactions = 20Mb of space + 
received files. 

• RAM requirements: 

 Windows NT 4.0 at least 128 MB (up to 5 simultaneous 
connections) and additional 4 MB for each concurrent 
user, 

 Windows 2000/XP at least 256 MB and additional 4 MB for 
each concurrent user, 

 Windows 2003 at least 384 MB and additional 4 MB for 
each concurrent user. 

Recommended RAM size differs from remaining applications operated 
by server. Main condition is, that server can manage without swapping 
memory. 

• Processor: at least Pentium II 400 MHz, 

• During installation Slovenian regional settings must be set as 
default. 

• IBM DB2 UDB base installation. 

• During installation server must be restarted at least once, with 
installation IBM DB2 v.7.2 on Windows XP or Windows 2003 at 
least two restarts must be allowed. 

3.2  Smart card reader 
Smart card reader could be purchased from bank or Electronic Banking 

Bureau, or use one already installed on PC. There are several types of 
readers on the market so available ports on the PC should be checked 
first (read section Error! Reference source not found.). USB readers 
are recommended for newer Desktop PCs, and PCMCI readers for 
notebooks. 

USB reader cannot be used on Windows 95 and Windows NT, because 
they don't support USB ports. 
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3.3 Connection to Hal E-Bank server 
Connection to Hal E-Bank server could be established via Internet or 

directly. Type of connection and all needed information (username and 
password for dial-up connection, port numbers to be opened on local 
firewalls) are provided by the bank. 

Any connection type (analog or ISDN connection, LAN, ADSL, cable 
Internet, liz line...) is needed for Internet. Local ISP provides technical 
support for Internet connection. 

Properly installed modem (analog or ISDN) and properly configured 
connection are needed for direct connection to bank server. 

To see how to configure connection read section Hal E-Bank Setup. 

3.4 Hal E-Bank software 
If you still don’t have program Hal E-Bank installed on your computer, 

please contact your account officer in the bank where you have an 
account opened. There you will get all the information needed to 
purchase the program, and the information about the ways of connecting 
to the bank.  

If you have program Hal E-Bank installed on your computer, you can 
upgrade the existing version with the new one by yourself. Use the option 
Program updating in Hal E-Bank program, explained in section 13.4 
Upgrading Hal E-Bank program. 

3.5 Bank agreement 
To use Hal E-Bank, first you need to make an agreement with the bank 

you want to work with. The bank should supply all needed information. 
All information about Hal E-Bank could be found on the web site Halcom 
informatika d.o.o.. 

3.6 Smart Card 
Smart Card represents the best commercial protection in the e-business 

today. It could be purchased in the bank where you have an account 
opened. 

In a case that you have opened accounts in a several banks that use 
Hal E-Bank system you don't have to purchase smart card for each bank. 
You have to purchase only one smart card (ONE FOR ALL) that can work 
with all accounts in all banks (that use Hal E-Bank system) without 
additional costs. Smart card, ONE FOR ALL, is provided by certification 
agency Halcom CA. More information about Halcom CA you could be 
found on the web site http://www.halcom-ca.si/index.php?section=1. 

By using smart card ONE FOR ALL you simplify your business, because 
you are using a single card. 

Smart card ONE FOR ALL owners could easily manage solvency of their 
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portfolio in all banks where they have accounts opened. At the same time 
they can see SUM of all account amounts in appropriate currency. 

Smart card ONE FOR ALL could be used for other purposes in e-
business e.g. for applications that require high level of protection and 
data security: 

• For digital signing of documents, e-forms, files etc.; 

• for sender authentication; 

• in applications for secure business between legal entities; 

Smart cards ONE FOR ALL, that Halcom CA use for storing digital 
signatures, provide highest level of security and transaction secrecy: they 
represent the most secure technology on the market. 

Halcom CA provides you with an envelope with personal number (PIN) 
for smart card ONE FOR ALL usage, as well as unblock smart card 
number (PUK). Do not store envelope and smart card together. Smart 
card and PIN or PUK numbers do not give to anyone. 

PIN 

Following the public policy of Halcom CA it is recommended to change 
personal number (PIN) after the first usage. It's recommended to change 
it at least once per month. Every time when you suspect that 
unauthorized person knows your PIN you should change it. To change 
PIN use Change PIN icon in the Hal E-Bank application. PIN must be at 
least 6 alphanumeric characters long. 

PUK 

We would like to inform you that smart card blocks if you enter wrong 
personal number (PIN) three times successively. In that case use the 
application for smart card unblocking and unblock smart card number 
(PUK). If you enter wrong PUK three times successively smart card will 
be permanently damaged. 

3.6.1 How to unblock a locked card? 

A smart card automatically locks itself if you enter a wrong PIN three 
times in a row. Wrong PIN entries are recorded on the smart card and 
are not deleted by restarting the computer! If you enter a correct PIN 
in your third attempt, the counter of wrong entries resets itself. A 
locked card issued by Halcom CA can be unblocked with PUK code, 
which you have received by Halcom CA with registered mail (together 
with PIN code). 

A smart card can be unblocked with the aid of a service program 
UnblockPIN.exe on web site 
http://wwweng.halcom.si/index.php?section=42. The program for 
unblocking cards needs to be downloaded and saved locally to the 
working station. Put the card into the reader. Run the program by 
double-clicking it. The program requires you to enter PUK code and to 
enter and confirm the new PIN code. PIN code contains 4 to 8 
characters. Cards issued after October 2005 require that PIN code 
contain minimally 6 characters. We recommend the use of a 
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combination of numbers and letters. More detailed instructions with 
display pictures can be found in the manual for using Hal E-Bank 
program. 

NOTE: Cards issued by certificate authority Halcom CA before 1 
March 2004, can only be unblocked personally in the central office of 
Halcom Informatika, Tržaška 118, Ljubljana by producing personal 
identification.  

A locked smart card can also be unblocked with the accompanying 
PUK code in iD2Personal program or Smart Trust Personal. This 
program (one of the two) is installed on each work station, where Hal 
E-Bank is installed and is used for reading the digital certificate on the 
smart card. When unblocking a card you should follow instructions of 
“SmartTrust Personal” program manufacturer. 

Warning: 

1. If you try to unblock a smart card with a wrong PUK code 
several times in a row, the card will automatically destroy 
itself.  

2. Before attempting to unblock a smart card please make sure 
you have the correct PUK code. PUK code is correct if the 
smart card number, written on the card under the chip 
(8888), is identical to the number contained under “Card No:” 
on the sheet containing PIN and PUK codes  
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4 Hal E-Bank installation 

4.1 Smart card reader installation 
If smart card reader is already installed on your computer then there is 

no need to install it again. In that case in the process of Hal E-Bank 
installation choose Custom installation and then Program files and ST 
Personal. 

4.1.1 Smart card readers with serial port (COM) 

First you have to install driver for smart card reader. After driver 
installation plug the smart card reader into the first available serial 
port on the back side of the computer (9 pin RS-232 connector). If 
smart card reader has power supply through the PS/2 port then 
connects it to the computer PS/2 port. If keyboard or mouse uses the 
same port then connect it to the other side of the smart card reader 
PS/2 port. 

4.1.1.1 Oberthur OCR 136 (Cardman 1010) installation 

When installing Hal E-Bank choose Installation with Oberthur 
Smart Card reader drivers. Pay attention which COM port you will 
choose. In case that you don’t know which port to choose (COM1, 
COM2, COM3,...) check it in the motherboard manual. Installation 
process depends of the version of operating system (Windows) 
installed on your computer. 

• Windows NT, 95, 98, ME 

When installing Hal E-Bank choose Installation with Oberthur 
Smart Card reader drivers. After Install Shield install reader, 
confirm license agreement, choose COM port and on question do 
you want to restart computer choose NO. After successful driver 
installation plug in reader, then restart computer! 

In a case that reader is not installed during the Hal E-Bank 
installation you have to install it manually. From installation CD 
(path:  X:\Oberthur_SC_reader_drivers) run setup.exe. Further 
steps are the same as installing Hal E-Bank with reader. 

• Windows 2000 

When installing Hal E-bank you must choose Custom 
installation with the following components: Program Files, ST 
Personal and Omnikey USB. Do not choose MS Smart Card Base 
Components!!! Further steps are the same as for Windows NT, 95, 
98, ME. 

• Windows XP/2003 

Installation process is the same as on Windows 2000. After 
restarting computer, when the reader is already plugged in, start 
the SmartCard service and set the startup type on automatic 
(Startup type – automatic). To define startup type in the Control 
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Panel, double-click on the Administrative Tools, and then double-
click on the Services (Start > Settings > Control Panel > 
Administrative tools > Services). In the list, right click on the Smart 
Card Service and choose Properties. In the Startup type field choose 
option Automatic. Service Smart Card helpers do not configure! 

4.1.2 Smart card readers with USB port 

Plug in the smart card reader in the USB port. 

4.1.2.1 Oberthur OCR 150 (Cardman 2020 or 3121) installation 

Installation process depends of the version of operating system 
(Windows) installed on your computer. 

• Windows 98, ME 

When installing Hal E-Bank choose Custom installation, and then 
choose following components Program files, ST Personal, MS 
smart card base and Oberthur*. 

* to make reader works on the WIN 98 and WIN ME you have to 
install driver for Oberthur COM reader and choose available COM 
port (for example COM 4). After driver installation and restarting 
computer, plug in the USB reader (while computer is 
running). When Windows recognize new hardware choose option 
Search for a suitable driver for my device and then click on the 
NEXT. Specify the path of the driver by choosing Specify location 
and then click on the NEXT (make sure that other options are 
unchecked). Click on the Browse and find drivers path on the CD 
ROM: X:\Oberthur_SC_reader _drivers\USB driver and then 
click on the OK, NEXT and FINISH. You have to restart computer. 

• Windows 2000 

Plug in reader while computer is running. When Windows recognize 
new hardware choose option Search for a suitable driver for my 
device and then click on the NEXT. Specify the path of the driver by 
choosing Specify location and then click on the NEXT (make sure 
that other options are unchecked). Click on the Browse and find 
drivers path on the CD ROM: X:\Oberthur_SC_reader 
_drivers\USB driver and then click on the OK, NEXT and FINISH. 
You have to restart computer. When installing Hal E-bank choose 
Custom Installation with the following components: Program 
files and ST Personal. 

• Windows XP 

Plug in reader while computer is running. Reader works without 
driver installation because Windows XP already contains driver in 
the driver library. When installing Hal Ebank choose Custom 
Installation with the following components: Program files and ST 
Personal. 

If reader doesn’t work start SmartTrust Smart Card service and set 
startup type on automatic. To start service and define startup type 
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in the Control Panel double-click on the Administrative Tools and 
then double-click on the Services (Start > Settings > Control Panel 
> Administrative tools > Services). In the list, right click on the 
SmartTrust Smart Card and choose option Properties. In the Startup 
type field choose option Automatic, and click on the Start. Click on 
the OK button to confirm changes and exit.  

Operating systems Windows 95 and NT does not support 
USB port. 

4.2 Hal E-Bank Installation 
Before installation make sure that: 

• basic hardware requirements are satisfied. Most critical is free 
space on the hard disk. Hal E-Bank application needs at least 
200MB of free space on the hard disk. Amount of free space 
depends on the number of the records that you want to keep in the 
database.  

• Windows version installed on the computer works correctly. If 
Windows doesn’t work correctly you have to correct all problems 
before installing Hal E-Bank application. 

Install program only when all requirements are satisfied. 

Program Hal E-Bank comes on installation CD. Insert CD into CD-ROM 
and wait for installation to begin. If installation process does not begin 
double-click on the file setup.exe on the installation CD. 

On the Welcome screen choose type of installation you want: Hal E-
Bank/Personal, Hal E-Bank/Corporate, IBM DB2 client for connection to 
the IBM DB2 database for multi user version, or you can choose Manual. 
To read Manual, Adobe Acrobat Reader must be previous installed on 
your computer. 

4.2.1 Hal E-Bank/Personal 

To install single user version of Hal E-Bank application you do not 
have to be a computer expert. 

On the welcome screen choose Hal E-Bank/Personal. On the next 
screen choose option to install application with a reader support. If 
your reader is not listed, or you already have installed drivers for 
reader, choose installation without reader support (Installation without 
smartcard reader PC/SC drivers). In that case drivers for reader install 
later following the manufacturer instruction manual. 

If you have Windows 2000 or XP, choose Custom installation and 
don’t choose option MS Smartcard Base, because the operating system 
already contains this component and new installation could cause work 
problems! 

Confirm selection, and leave all other predefined selections. 

At the end of installation process you may see the screen that 
informs you that the installation process is finished and computer 
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should be restarted. Choose option “No I will restart my computer 
later” and click on the button Finish. Restart computer when Install 
Shield disappear from the Taskbar. 

4.2.2 Hal E-Bank/Corporate 

Multi user version of Hal E-Bank application has all functionalities for 
single user version but also additional functionalities for multi user 
environment. Multi user version of Hal E-Bank application is based on 
the central database. In this version multiple users with different rights 
can work at the same time. 

Installation of multi user version is more complicated then single user 
version. On each workstation you have to install Hal E-Bank client (The 
procedure is same as for Hal E-Bank/Personal, only you have to choose 
Hal E-Bank/Corporate on the Welcome screen), IBM DB2 client and to 
establish communication with central IBM DB2 database. Installation of 
IBM DB2 and communication configuration should be performed by a 
skilled technician. 

4.3 Upgrade Hal E-Bank on version 11.1.2.01 
Attention before upgrade process 

In the newest version packages are implemented, so folders 
Preparation and Send should be empty. All prepared payment orders 
sign and send to the bank, or export to the .txt file and delete. After 
upgrade process is finished you can import those payment orders into Hal 
E-Bank. If you want to delete signed payment orders before upgrade, you 
have to unlock them. 

Upgrade process 

On the workstation with installed Hal E-Bank (version 11.1.2.01 or 
newer), from installation CD run Setup.exe and choose version of Hal E-
Bank you want to install. Choose Custom installation, then component 
Program Files on the location where old installation exists. 

Upgrade process for Hal E-Bank/Corporate 

On the workstation with installed Hal E-Bank/Corporate (version older 
then 11.1.2.01) from installation CD-a run Setup.exe and choose Hal E-
Bank /Corporate. Choose Upgrade current installation, then component 
Program Files on the location where old installation exists. During the 
upgrade, program will inform that database have to be upgraded too. You 
can find database upgrade manual on the installation CD.  

4.4 Connection parameters 
File sifrant_bank.dat (located in the application path) contains 

communication parameters for data exchange between Hal E-Bank 
application and servers of all banks in the Hal E-Bank system. You can 
use an external application, named ConnectionSettings.exe, to define 
communication parameters. Using this program for each bank you can 
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define type of communication, IP address, Name of dialup connection. In 
case you choose https type of connection you can define https IP address 
also (see the picture below). 

 

Figure 1: Connection parameters 

Select the bank from dropdown menu, choose communication type 
and/or IP address, and then confirm selection by clicking on the button 
Confirm. 

You cannot connect to the bank if connection parameters are not 
properly set. We recommend setting the communication parameters 
before you start the program for the very first time. 

Bad communication system has influence on the data transmition 
speed, and sometimes causes data exchange breakdown. 
Communication through the modem has to be secured from the 
environment influences. 

4.5 Installation of TCP/IP Protocol and Dial-up 
Networking –   Windows 95/98 

 

4.6 Installation of Dial-up Networking support 
 
 

Check if Dial-up Networking support has already been installed on 
your computer.  
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You do this by clicking Start, selecting Settings and then Control 
Panel. When it opens, double-click on the Add/Remove Programs, 
Select Windows Setup, then Communications and click Details. If 
Dial-up Networking is selected, then the Dial-up Networking support 
has already been installed. If it is not selected, select it and click OK 
and then again OK.  When installing Dial-up Networking support be 
sure to have floppy disks or CD-ROM Windows 95/98 at hand. If you 
have not written the name of your computer and workgroup into the 
network identification yet, you will be alerted.  You can put down 
anything into the fields Computer name and Workgroup. After you 
have installed Dial-up Networking support, restart your computer.  
When rebooting your computer, you will be asked to enter your 
Username and Password to enter Windows.  If you enter your name for 
Username and leave the Password field blank, the computer will not 
ask you to write down the two items by the next startup. 

       

When Dial-up Networking support is installed, you can continue by 
installing TCP/IP Protocol. 

 

4.7  Installation of TCP/IP Protocol 

Check if Dial-up Networking driver and TCP/IP protocol have 
already been installed on your computer. 

 

Click Start, select Settings and then Control Panel.  Double-click 
on Network. A new window similar to the one below will appear on 
the screen (Figure 2: Network). 
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           Figure 2: Network   

 

For Proklik NLB to operate successfully, Dial-up Networking driver 
and Protocol TCP/IP must be installed. If they both appear in the 
dialog box (Figure 2: Network), you can continue with 4.5.3 Creating 
icon with a link. 

 

To install Dial-up Networking driver, click Add, double-click 
Network Interface Card/Driver and select Microsoft amongst the 
Manufacturers.  Select Dial-up Networking driver in the second 
field and click OK.  

  

You have now installed the Dial-up Networking driver. 

If you want to install Protocol TCP/IP, click Add, double-click 
Protocol and select Microsoft amongst the Manufacturers, and 
TCP/IP amongst the Network protocol. Click OK. 

 

Now your network configuration should include Dial-up Networking 
driver and TCP/IP. 

 

Check if Dial-up Networking driver is successfully connected to the 
Protocol TCP/IP. Select Dial-up Networking driver in the dialog box 
Network. Click Properties and then Links to check if Protocol TCP/IP 
is on.  

  

If you have installed Protocol TCP/IP or Dial-up Networking driver, 
you will be asked to restart your computer. 
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4.8 Creating icon with a link 

You can find precise instructions about creating icon with a link in 
Help for Windows 95/98. Here described is only a basic procedure for 
creating icon with a link. Double-click My computer and then double-
click Dial-up Networking (Figure 3: Dial-up Networking). If you have 
entered Dial-up Networking for the first time, the computer will offer 
you Creating icon with a link, otherwise double-click Make New 
Connection in Dial-up Networking folder. 

    

 

 

Figure 3: Dial-up Networking 

 

If modem drivers have not been installed yet, the program will 
ask you to install them. You got instructions for installing 
modem drivers into Windows operating system when you 
bought your modem. 

 

When you have installed your modem successfully, a new dialog box 
for creating a link will appear: 
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Figure 4: New Connection  

  
 

Enter NLB into the Enter computer name you wish to call (Figure 
4: New Connection) field. In the next field, select a modem you have 
set when installing Windows 95/98 operating system or modem. Then 
select Configuration. 

   

 

Figure 5: Modem installation  

 
By selecting Configuration, a new window will appear (Figure 5: 

Modem installation) containing various modem settings. Click the 
Connection tab and turn off Wait for dial tone. Click OK button to 
confirm the changes. 

   

 

To proceed click Next> in the New Connection widow (Figure 6: 
New Connection 1). 
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Figure 6: New Connection 1 

 
 

You have to enter area code, telephone number and country code 
into the upper window. Set Area code to 01 and enter the number 
you have received from the bank into the Telephone number field. In 
the Country code field select Slovenija (386) from the list of 
countries by using the scroll box and click Next>. 

   

 

Figure 7: New Connection 2 

 
In the next window (Figure 7: New Connection 2) the program 

informs you that you have created a new connection.  If you want to 
save it, click Finish.  
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4.8.1 Setting properties for icon with a link 

This chapter explains how to set properties of the icon intended for 
connecting to Dial-up Networking. Select a new icon in the Dial-up 
connection window so that it is selected inversely. By clicking the 
right mouse button, a scrollbar will appear. Select Properties by 
using a mouse (Figure 8: Setting properties for the icon with a link). 

   

 

Figure 8: Setting icon properties 

 
 

A dialog box will appear: 

 

 

Figure 9: Icon properties 
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Click the Server type tab. 

  

 

Figure 10: Icon properties 1 

 
  

Select PPP: Windows 95/98, Windows NT 3.5, Internet in the 
Dial-up server type. Of all the other options in the window, only 
TCP/IP field should remain on. 

   

Click the Settings for TCP/IP button. 

 

 

Figure 11: TCP/IP settings  
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Click the TCP/IP settings button. 

Click the Enter IP address field and enter the IP address you 
have received from the bank into the IP Address field.  

Click Server assigned name server addresses and Use IP 
header compression. Turn off the Use default gateway on 
remote network field. Click OK to confirm changes in all three 
active windows. 

4.8.1.1 Manual testing of establishing the first connection to 
NLB 

Double-click on the NLB icon in the Dial-up Networking folder. A 
new window appears in which you enter your User Name and 
Password you have received from NLB in an envelope.  

 

Figure 12: Connection with: 

 
 

After you have entered your User Name and Password, click 
Connect.  Modem will try to establish a connection with the 
network.  

If you have followed the instructions, the connection with the 
bank’s network will be established and the computer will inform you 
about it with the following dialog box.  

 

Figure 13: Connecting to bank’s server 

  
 

If the above window appears, the connection has been successfully 
established.  If the connection has failed, check all the settings 
again or call technical support.  

Your computer is now ready.  We wish you a successful operation!  
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Figure 14: A successful connection 

 

4.9 Installation of TCP/IP Protocol and Dial-up 
Networking –   Windows NT 

4.9.1 Installation of Dial-up Networking support  

 

On the desktop select and open My Computer/Dial-up Networking.   

 

             Figure 15: Dial-Up Network   

 

Click Install in a dialog window (Figure 15: Dial-Up Network).  

Installation requires files which are on your WIN NT installation CD.  
When the program asks you about the location of unknown files, insert 
the disc into the driver and click OK.  

After installing Dial-up Networking, the computer will ask you about modem 
installation.  Do not change default options in the Install New Modem (Figure 
16: Install New Modem) window and click Next>. 
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Figure 16: Install New Modem 

 The computer will try to find your modem (Figure 17: Install New 
Modem 1). If it finds it, select it and click Next>.  

 

Figure 17: Install New Modem 1 

Confirm your choice in the next window by clicking Finish.  

If the computer does not find your modem, install it according to the 
instructions provided by its producer.  

After installing the modem, the program will ask you to restart your 
computer.  

 

4.9.2 Creating a new connection  

 

Select and open My Computer/Dial-up Networking on the 
desktop.  

In case the connection has not been established yet, a notice will 
appear. Confirm it by clicking OK.  
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Figure 18: New Phonebook Entry Wizard 

Enter the name of the connection into the Wizard dialog box for 
creating a new connection (Figure 18: New Phonebook Entry Wizard) 
and click Next>.  

 

Figure 19: Server   

Select I am Calling the Internet in the next window (Figure 19: 
Server) and click Next>.  Select  Use Telephony dialing properties.  

The next step is entering phone number, where you select Slovenija 
as a country, area code 01 and server number, for example enter 
5878800 for Nova ljubljanska banka (Figure 20: Phone Number). 
Confirm the change by clicking Next>.  
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Figure 20: Phone Number  

Click Finish to confirm the procedure.  

 

Figure 21: Dial-Up Networking   

It is important to check modem settings.  You do this by clicking 
More (Figure 21: Dial-Up Networking) and selecting Edit entry and 
modem properties.  

 

Figure 22: Edit Phonebook Entry – Server 

In the second Server (Figure 22: Edit Phonebook Entry – Server) tab 
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select only TCP/IP as shown on the picture above. Press TCP/IP 
Settings.  In the next window, do not change default values as shown 
on the picture below (Figure 23: PPP TCP/IP Settings).   

 

Figure 23: PPP TCP/IP Settings 

Select Specify an IP address (Figure 23: PPP TCP/IP Settings) and 
enter the IP address you have received from the bank into the IP 
address field.  Click the OK button to confirm your selection.    

 

Figure 24: Edit Phonebook Entry – Security 

In the Security tab (Figure 24: Edit Phonebook Entry – Security) 
select  Accept any authentication.  Click the OK button to confirm 
your selection.     

In case you want to check the new connection, click Dial and enter 
your User Name and Password. Leave the Domain blank (Figure 25: 
Connect to …).  
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Figure 25: Connect to …  

4.10 Installation of TCP/IP Protocol and Dial-up 
Networking – Windows 2000 

 
If you wish to install a new connection to the call and Dial-up 

Networking support and modem have already been installed, follow the 
instructions for Creating a new connection.  

4.10.1 Creating a new connection 

Click Start and select Settings/Network and dial-up connections.  
Double-click the Make New Connection icon.   

 

Figure 26: Make a New Connection 

 A new window will appear (Figure 27: Network Connection Wizard). 
Click the Next> button.   
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Figure 27:  Network Connection Wizard 

Select Dial-up to private network in the window that opens (Figure 
28:  Network Connection Type) and click the Next> button.      

 

Figure 28:  Network Connection Type 

In the next window (Figure 29:  Select a Device) select a modem you 
wish to establish the connection with and click the Next> button.      

 

Figure 29:  Select a Device 
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The next step is entering a phone number, where you select 
Slovenija as a country, area code 01 and server number, for example 
enter 5878800 for Nova ljubljanska banka (Figure 30: Phone Number 
to Dial). Click the Next> button again to confirm your selection.   

 

Figure 30: Phone Number to Dial 

If the below window appears (Figure 31:  Smart Cards), select  Do 
not use my smart card and confirm your selection by clicking Next>.    

 

Figure 31:  Smart Cards 

In the next window (Figure 32: Connection Availability) select   For 
all users. By this you enable all users, who log in on the computer, 
the access to the Dial-up Networking icon. Click the OK button to 
confirm your selection.   
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Figure 32: Connection Availability 

 

Figure 33:  Completing the Network Connection Wizard 

In the above window (Figure 33:  Completing the Network 
Connection Wizard) enter the name of the connection (for example: 
NLB) and click Finish.  In the next window (Figure 34: Connect) click 
Properties. 

 

Figure 34: Connect 
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Select the Networking tab (Figure 35: “Networking” Tab) and click 
Settings.  

 

Figure 35: “Networking” Tab 

Deselect all options in PPP Settings window and click OK.  The 
above window reappears (Figure 35: “Networking” Tab). Select 
Internet protocol (TCP/IP) in the Components checked are used by 
this connection field and click Properties.   Deselect all other options. 

In the window that appears (Figure 36: Internet Protocol (TCP/IP) 
Properties) select  Use the following IP address and enter IP 
address which you have received from the bank in the field IP 
address. Then click Advanced. 

 

Figure 36:  Internet Protocol (TCP/IP) Properties 
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Figure 37: Advanced TCP/IP Settings 

In the (Figure 37: Advanced TCP/IP Settings) select the General tab 
and deselect Use default gateway on remote network. Click the 
OK button to confirm all the settings.    

4.10.2 Manual testing of the connection 

Double-click on the created connection which is in the 
Start/Settings/Network and Dial-Up Connections folder.  A 
window appears (Figure 34: Connect) in which you enter your User 
Name and Password you have received from the bank. After you have 
entered your User Name and Password, click Dial.  Modem will try to 
establish a connection with the network. The Connecting window 
appears.  

 
Figure 38: A successful connection 

If the connection has failed, check again the following: all the 
settings, User Name and Password. The computer is now ready to 
operate. We wish you a successful operation! 
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4.11 Installation of TCP/IP Protocol and Dial-up 
Networking –   Windows XP 

4.11.1 Creating a new connection 

Click Start/Control Panel/Network and Internet Connections 
(Figure 39:  Network and Internet Connections). 

 

Figure 39:  Network and Internet Connections 

Click Create a new connection. 

 

Figure 40:  New Connection Wizard 

A new window will appear (Click the Next> button. 
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Figure 41:  Network Connection Type 

In the above shown window (Figure 41: Network Connection Type) 
select  Connect to the network at my workplace and click 
Next>.   

 

Figure 42:  Network Connection 

A  Network Connection window (Figure 42: Network Connection) 
appears. Select  Dial-up connection.  Continue by clicking the 
Next> button. 
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Figure 43: Connection Name 

Enter the name of the connection in block capitals in the edit box. 
Continue by pressing Next>. 

 

Figure 44: Phone Number to Dial 

The next step is entering the phone number, for example 01 
5878800 for Nova ljubljanska banka (Figure 44: Phone Number to 
Dial).  Confirm your choice by clicking Next>. 

If the below shown window appears (Figure 45: Smart Cards), select 
 Do not use my smart card and confirm your selection by clicking 

Next>. 
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Figure 45:  Smart Cards 

In the below window (Figure 46: Completing the Network Connection 
Wizard) click Finish. 

 

Figure 46:  Completing the Network Connection Wizard 

In the next window (Figure 47: Connect) enter your user name and 
password you have received and click Properties. 
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Figure 47: Connect 

 

Select the Networking tab (Figure 48: “Networking” Tab) and click 
Settings.   

 

Figure 48: “Networking” Tab  

Deselect all options in PPP Settings window and click OK.  The 
above window reappears (Figure 48: “Networking” Tab). Select 
Internet protocol (TCP/IP) in the Components checked are used by 
this connection field and click Properties.   Deselect all other options. 

In the window that appears (Figure 49: Internet Protocol (TCP/IP) 
Properties) select  Use the following IP address and enter IP 
address which you have received from the bank in the IP address 
field. Then click Advanced. 
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Figure 49:  Internet Protocol (TCP/IP) Properties  

In the above window (Figure 49:  Internet Protocol (TCP/IP) 
Properties) select Obtain an IP address automatically and Obtain 
DNS server address automatically.  Click the Advanced button to 
confirm your selection. 

In the below window (Figure 50: Advanced TCP/IP Settings) select 
the General tab and deselect  Use default gateway on remote 
network.  

Click the OK button to confirm all the settings. 

 

Figure 50: Advanced TCP/IP Settings 
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The computer is now ready to operate. We wish you a successful 
operation! 
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5 First steps 

5.1 Starting Hal E-Bank 
Properly insert smart card into smart card reader (Error! Reference 

source not found.).  

 

Figure 51: Inserting smart card 

The Hal E-Bank can be started in two ways: 

• by double-clicking the Hal E-Bank/Personal (or Hal E-
Bank/Corporate) icon on desktop, or 

• by clicking Start, Programs (or All Programs), e-bank, 
Personal E-Bank (or Corporate E-Bank). 

After starting the program, the Welcome window opens (Error! 
Reference source not found.). Enter personal number (PIN) of the 
smart card and press <Enter>. When logging in, Smart Card should be 
properly placed into the reader. If there is no security Smart Card in the 
reader, usage of the program will not be possible. 

Before logging on, please check where on the keyboard are buttons Y 
and Z. There is a possibility of these two buttons being exchanged. In 
that case it is possible that you without the need enter wrong personal 
number several times and by doing so destroy the security Smart card 

If your personal number (PIN) contains letters Y or Z we suggest 
changing it. Personal number (PIN) could be changed from Hal E-Bank by 
selecting option Tools, Personal number (PIN) change from menu, or 
by clicking on the Change PIN icon on toolbar. Description how to 
change personal number is explained in detail in a section Infrequent 
Activities. 
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Figure 52: Welcome screen 

If entered personal number (PIN) is incorrect warning will be displayed. 

 

Incorrectly entering your personal number (PIN code) three times in a 
row will cause the smart card to lock up and become unusable. To 
unblock your smart card you need to enter the PUK (Personal Unblocking 
Key) code that was provided to you with the smart card. Incorrectly 
entering your PUK code three times in a row will cause the smart card to 
destroy itself and become permanently unusable. 

After entering the correct PIN the Hal E-Bank program opens the 
dialogue box for making the first connection with the bank.  

5.2 Establishing first connection with the bank 
Among other information, the Hal E-Bank program keeps the 

information on authorized users for the program. 

When first starting the Hal E-Bank program, user information from the 
user's certificate on a smart card and his account information are not yet 
present in the local database. The program first offers a list of banks that 
the user can connect to. The user highlights the bank and clicks 
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Connect. If the selected bank accepts the user's identity, the e-bank 
opens its door to the user and remembers the user’s information from his 
smart card. If not, it rejects the user. 

 

Figure 53: First connection with the bank 

5.2.1 First connection with the bank from the list 

To make first connection with the bank you want to work with do the 
following: 

In the Bank selection dialog box (Error! Reference source not 
found.) select the bank you want to work with. Selected bank has to 
be highlighted. 

Click on the Connect button or press <Enter>, if button Connect is 
active. 

PIN dialog box shows up (Error! Reference source not found.), 
which asks you to enter your personal number (PIN) in order to access 
the information on your smart card. 

 

Figure 54: Personal number (PIN) entry 

Enter your personal number (PIN) and click on the Ok or press 
<Enter>. Establishing connection could be cancelled by clicking on the 
Cancel button. 
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If you do not have the authorization to connect to the selected bank, 
or if you have tried to connect with the wrong smart card, the program 
issues a message. To close message click on the Ok, or press 
<Enter>. 

5.3 Exiting Hal E-Bank program 
You must not simply shut down the Hal E-Bank program since the 

program uses a database that might become damaged without proper 
exit for the program. If the database becomes damaged, the program will 
malfunction which will prevent you from using the program. 

If you want to finish working with the Hal E-Bank program do the 
following: 

From the File menu select Exit or click the white cross on the toolbar. 

 

5.4 Establishing connection with the bank 
using a dial-up modem 

During the work in the Hal E-Bank you have to connect with the bank, 
from time to time, to send or receive documents. If you use a dial-up 
modem to connect with the bank, every time when establishing 
connection you have to enter user name and password. Username and 
password are provided by the bank. 

Warning: password IS NOT personal number (PIN), that you use for 
entering into Hal E-Bank and for performing transactions (personal 
number - PIN code of smart card). 

When establishing connection with the bank a dialog box for entering 
username and password will be displayed. 

 

Figure 55: Dialog box for entering username and password. 

Enter username and password and click Ok or press <Enter>. When 
entering password be careful with capital and small letters. Check the 
position of Y and Z keys on the keyboard also. 

If you want password to be saved for the future live the check box 
Save password checked, as it's shown in a figure above.
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6 Hal E-Bank authorization system 

Hal E-Bank operation is based on the system of authorizations which are 
given by the bank's employee upon client's request. An independent 
entrepreneur or a legal entity can have several authorized employees who 
are registered to use the Personal or Corporate version of the Hal E-Bank 
program.  

If the information about the user’s certificate from the smart card is not 
yet present in the local database, the Hal E-Bank program sends a request 
for checking user’s authorization to the bank’s server. If the user is 
authorized in the local database of the Hal E-Bank program, he or she can 
use the program. Otherwise the program forbids access to the e-bank and 
shows the following message: 

 

User’s authorization is linked to the selected account. The user can have 
different authorizations for accessing the accounts at different banks. The 
user can have combined authorizations. In this case, the user has joint 
authorizations from combined groups of authorizations. 

Depending on the user's authorizations, some buttons, icons and menu 
items might be inactive (greyed-out) therefore those functions will not be 
available. Icons for changing the personal identification number (PIN), first 
connection with the bank and exiting the program (white cross) are always 
active.  

Authorizations are saved in the database of users’ information at a bank in 
an encrypted profile. The bank has a record of all the users and their 
authorizations. Clients profiles are synchronized with the situation in the 
bank upon every connection made with the bank. 

6.1 Authorizations for using Hal E-Bank 
In the Hal E-Bank system there are two kinds of authorization: for 

working with selected account and for working with files.  

1. Authorizations for working with the selected account: 

• Authorization for inputting information allows only 
preparation or entering the information to payment orders and 
address book, 

• Authorization for package preparation allows creation of 
payment orders into package (e.g. if you are not authorized for 
package preparation, payment orders should be signed 
individually), 

• Authorization for signing allows only viewing of payment 
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orders and package signing, and at the same time changing and 
adding to the address book, 

• Authorization for sending information allows data 
transmission between bank server and local Hal E-Bank 
database, 

• Authorization for sending to sign allows orders transmission 
on bank server for remote signing.  

• Authorization for viewing allows viewing of actions, 
statements, balance, account statements sent by the bank, etc., 

• Authorization for administration allows administrative actions 
in Hal E-Bank program, such as deleting the local data base, 
synchronization of information from bank’s server, etc. 

2. Authorizations for working with the files: 

• Authorization for imputing files allows file preparation, and 
file importing, 

• Authorization for signing  allows viewing files and their 
signing,  

• Authorization for sending files allows file transmission 
between bank server and local Hal E-Bank database, 

• Authorization for viewing files allows file viewing. 

Beside these authorizations there is also a signature category, but 
which does not additionally limit program functionalities. A signature 
category merely states which signatures the user can realize. A particular 
number of required left-side and right-side signatures are set for each 
account. There can be a minimum of 0 and a maximum of 3 left-side 
signatures. There can be a minimum of 1 and a maximum of 3 right-side 
signatures 

Users that sign documents are put into four signature categories: 

• signature category [1]: enables the user to realize all missing 
left-side and right-side signatures, which means that he or she 
alone can sign all documents, 

• signature category [2]: enables the user left-side or right-side 
signing, depending on signing order, 

• signature category [3]: enables only left-side signing, 

• signature category [4]: enables only right-side signing. 

To check out what level of authorization you have in dealing with the 
bank click on the button Account owner.  

 

The window displayed shows the information about the owner of the 
selected account and the authorized person, who is currently logged-in 

to the Hal E-Bank program 
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Figure 56: Authorization report 

You can leave this report by clicking  ⇐ back. 
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7 Everyday activities 

7.1 Selecting type of payment 
Hal E-Bank enables two basic types of payment: Domestic Payment and 

Foreign Payment. If your bank enables you both types of payment you 
can select either of them in the toolbar field (Error! Reference source 
not found.). 

Click the down arrow button right to the toolbar field to select either 
Domestic or Foreign Payment System. 

The selected type of payment influences the displayed contents in 
folders. If you can not find the document you want first check 
whether you have selected the right type of payment. 

 

Figure 57: Payment system, account and time period 

7.2 Selecting account 
You can have several accounts open with different banks. Records about 

transactions and payment orders are kept for each account separately. 
The selected account appears in the Account field (upper right part of the 
program window)(Figure 1). It determines also the information displayed 
in the main window. Only those items are displayed which belong to the 
selected account. 

If you want to select different account click the arrow right of the field 
with the account number. A list of accounts with the logo of the bank is 
shown. Select the requested account from the list by clicking it. 
Information about the selected transaction account is be shown with all 
the actions that can be performed on it. If the selected account does not 
have the authorization for using the currently active folder, a message is 
displayed with the user's information and his authorization. You have to 
select the appropriate action on the authorization displayed.  

If you can not find certain order in the folders listed above, first check if 
you have selected the right account. 

7.3 Setting the time period for data review 
Setting the time period for data review is setting the time period for 

which you want the information to be displayed. You can limit the time 
period in folders Archive and Review. To do this use Review data for 
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fields in the main program window 

You set the requested period by selecting the starting and ending date 
according to one of the two procedures explained below. In the filtered 
folder, only those lines with information about the documents will be 
displayed which correspond to the selected period, with starting and 
ending date included. 

If you want to display the entire document for a selected day, week, or 
month, do this by selecting DAY, WEEK or MONTH in the first field. 
Then by clicking on the arrows right from that field change the period for 
a day, week, or a month a step forward or backward. 

Second way to set the time period is direct way. In the first field choose 
FREE. In the second field select starting date, ad in the third field select 
ending date. 

Processes of filtering and limiting the period are mutually exclusive. If 
you have the filter turned on, fields for limiting the period shown on the 
screen are unavailable (greyed-out). If you despite that, want to show all 
documents for the selected period, remove the filter before that, or put 
the wanted period as a parameter in the filter. 

7.4 Working with document folders 
Every line shown at the central part of the main window represents a 

separate document: payment order, batch, message, transaction, 
statement, or notice. Each line shows only the basic information needed 
for identification of a certain document. Contents of that part of the 
window change in relation to the folder currently selected the selected 
account, time period, and filter. Details about a certain document can be 
displayed by selecting the document with the click of a mouse and then 
clicking Open or Details, depending on the folder currently opened.  

Use the slider bar to review all the documents if there are too many 
rows or columns displayed. 

You can change the width of columns by moving the mouse pointer to 
the border between field with the names of adjacent columns for example 
to the border between field Value date and Credit. When the pointer 
changes the shape, drag the border so that the left column spreads, or 
reduces in size to the desired width. 

7.4.1 Document folder organization 

The document folders are grouped by names: Preparation, 
Delivery, Review, Archive, and Info. The names of groups are 
depicted by figures from the left side for easier identification, and are 
put on darker grey background. By clicking on the group of folders a 
list of folders under it opens. Names of folders also have small figures 
beside them for easier identification, and are put on lighter 
background. 

To select the folder that belongs to currently opened group, click the 
icon or the name of the folder. To select the folder that does not 
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belong to currently opened group, first click on the icon or the name of 
the group it belongs to, then additionally on the icon or the name of 
the selected folder. 

Colours of shown icons or names of the folders mean: 

Red name of the folder: currently displayed (active) folder, 
Grey name of the folder: no authorization to use that folder, 
Black name of the folder: you have authorization to use that folder. 

7.4.2 How to mark multiple lines 

As you would in the course of using the program need the function of 
marking multiple orders, payment orders and other documents, it is 
good that you are informed about this usage at this point. 

When marking multiple lines (records) on the screen, you should use 
<Shift> and <Ctrl> keyboard key. By using the<Ctrl> key you can 
select nonadjacent lines (for example payment orders or actions). 
Mark the first line while pressing the <Ctrl> key and then clicking 
remaining lines one by one. All the selected lines will be highlighted 
(inversed). By using the <Shift> key you can select lines which are 
adjacent in the list. With the left mouse button can click the first line 
and while holding the <Shift> key click the last line that you would 
like to mark. All the lines will be marked, from selected first one to the 
last one included. 

Use the slider bar to review all the documents if there are too many 
rows or columns displayed. 

7.4.3 Changing the order of documents in folders 

The order in which the documents are displayed in folders can be 
changed by clicking the appropriate column. Thus, for example in the 
Preparation of orders folder, displayed lines can be sorted by the 
amount by clicking the column Amount. If you click on the same field 
again, the rows will be sorted in reverse order. 

The order, ascending or descending, by which the rows are sorted 
depending on the value in the selected column, is indicated by the 
arrow pointing up or down, which is displayed on the right side of the 
column name. 

7.5 Filtering document folders 
When you have a large number of documents we recommend filtering 

for selecting the desired documents for display. In addition to simplifying 
your search for a particular document or a group of documents by 
increasing the neatness of presentation, the filters also represent a 
simple tool for performing queries. With the filter in use (in the active 
folder) only those documents that satisfy the conditions set by the filter 
are displayed. In other words: the filter hides every 20 documents that 
does not comply with any of the conditions set. That of course does not 
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mean that the document is not in the database, but only that it is not 
displayed.  

In different folders the filters are different, because the documents 
contain different information by which it makes sense to be filtered. 

Basic methods and procedures with using the filters are the same. 
Below, procedures common to using all the filters are explained first, and 
after them specific filters that depend on the selected folder are 
explained. 

If filtering is applied on a folder displayed, buttons Change filter 
and Remove filter are visible right of the field Review data for. 

7.5.1 Turning the filter on 

 When starting the program all the filters are off. 

In the currently active folder, you turn on the filter by either: 

• Clicking on Filter on the toolbar, or 

• Selecting Filter in the Tools menu. 

 

Window for entering the values in the filter is displayed on the 
screen. That window is different for each of the folders that you can 
filter. Enter the value of limit values that you want used when filtering 
the documents. Unfilled (empty) fields will have no influence on 
filtering. 

To confirm the entered values and turn the filter on, click on the 
Filter button. To cancel entered values click on the Cancel button. 
Note that if the filter was already turned on, canceling does not mean 
turning the filter off. Filtering will be carried out with the values 
previously entered. 

After being turned on the filter remains active until you remove it or 
exit the Hal E-Bank program. Each of the three folders where filtering 
of documents is enabled (Preparation, Archive, Review) has its own 
filter. For example, if you filter Preparation/orders folder and 
continue your work in the Review/transactions folder and change 
filter in it, when you back into Preparation/orders folder, it's filtered as 
it was when you left it. 

7.5.2 Changing an active filter 

To change active filter click on the Change filter, and 
then follow steps from section Error! Reference source not 
found..  

7.5.3 Removing the filter 

Remove an active filter by clicking the Remove filter 
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button. Last entered values in the filter are saved even after removing 
the filter, but only until you have closed the Hal E-Bank program. 
When you turn on the filter on of the same folder next time, you will 
be offered the values that were used with the last filtering, before 
removing the filter. 

7.5.4 Filtering prepared orders 

Window for entering values in the filter for the Preparation/orders 
folder is shown below (Error! Reference source not found.). You 
can filter the folder according to the following categories: 

• Select a– select the type of document from drop-down list. 
Choice All agrees with any type of document. 

• Value Date – you can change upper or lower limit date only if 
the field left from the date of currency is ticked. 

• Receiver – beneficiary's name or part of it. 

• Amount – enter lowest and highest amount. Empty field of the 
lowest value is taken to be value 0, while empty field of the 
highest value means that the highest value is not limited. 

• Details - enter the purpose of payment or part if it. 

• Status - select from drop-down list. Empty field allows all 
statuses. 

• Creation date – enter starting and ending date. 

• Prepared by – enter first few characters of the name of person 
who prepared the document. 

• Signed by – enter first few characters of the name of person 
who authorized the document. 
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Figure 58: Filtering orders 

7.5.5 Filtering archived orders 

 Window for entering values in the filter for the Archive/orders folder 
is shown below (Error! Reference source not found.). You can filter 
the folder according to the following categories: 

• Select a – select the type of document from drop-down list. 
Choice All agrees with any type of document. 

• Debit account number – enter debit account number. 

• Value Date – you can change upper or lower limit date only if 
the field left from the date of currency is ticked. 

• Receiver – beneficiary's name or part of it. 

• Amount – enter lowest and highest amount. Empty field of the 
lowest value is taken to be value 0, while empty field of the 
highest value means that the highest value is not limited. 

• Details - enter the purpose of payment or part if it. 

• Status - select from drop-down list. Empty field allows all 
statuses. 

• Creation date – enter starting and ending date. 
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• Prepared by – enter first few characters of the name of person 
who prepared the document. 

• Signed by – enter first few characters of the name of person 
who authorized the document. 

 

Figure 59: Filtering archived orders 

7.5.6 Filtering transactions 

 Window for entering values in the filter for the Archive/orders folder 
is shown below (Error! Reference source not found.). You can filter 
the folder according to the following categories: 

• Select a – is selected Transaction. 

• Debit account number – enter debit account number. 

• Booking date – enter starting and ending date. 

• Value date - you can change upper or lower limit date only if 
the field left from the date of creation is current, similar to what 
applies to the date of currency when filtering the 
Preparation/order folder. 

• Rejected orders – there is three possibilities: 
included/excluded/only returned orders. Choosing only returned 
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orders fields booking date, booking entry type and name are 
disabled (this fields are excluded from filtering). 

• Booking entry type – select the type of record from drop-down 
list. Empty field allows all types of record. 

• Amount – enter lowest and highest value. Empty field of the 
lowest value is taken to be value 0, while empty field of the 
highest value means that the highest value is not limited. 

• Name – enter alphanumeric string for the name. 

• Details - enter alphanumeric string for the purpose of the order. 

 

Figure 60: Filtering transactions 
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8 Payment orders 

Hal E-Bank enables paying with two different types of payment orders:  

• Ordinary payment order BN01, 

• Special payment slip, 

• Compensation payment order BN01 

Making payments with these kinds of payment orders is explained in detail 
in the following sections. 

Processing payment orders is carried out in several phases. Every phase 
can be performed only by a person who has the appropriate level of 
authorization. The phases of processing the payment order are filling out 
payment order, signing, and sending the payment order to the bank. 
Changes when filling out certain fields are given immediately in the process 
of filling out the payment order. Payment order can be sent to the bank 
only after it has passed all phases of preparation. 

Colors of payment orders in the Preparation folder are: 

Colors of payment order 
in map for preparing 
payment order 

Status of payment 
order 

Description in 
column “Status” 

Green Prepared order PREPARED 

Blue Order with an error WITH ERROR 

Red Signed order CHECKED 

Purple Sample order TEMPLATE 

Purple On Remote Signing 
(WEB) 

ON REMOTE SIGNING 

Purple Returned from remote 
signing (WEB) 

RETURNED FROM REMOTE 
SIGNING 

Marking in the first column of map Preparing 
order 

 

N Urgent order 

? Order with an error 

 

Window for entering data into the payment order is similar to the paper 
version of the payment order, so that it enables simple entry of data. Your 
data are automatically shown in the right fields of the payment order. Your 
task is only to add the remaining data. You can draft payment orders in 
advance. That means that the bank will send them to be paid with the date 
in the future, which is stated on the order. Stating the date that has passed 
is not possible. If the payment order has a date that is in the past, the 
order will be processed with the first possible date. 

For entering the information into the payment order you can move the 
cursor between different fields and within the field by using the mouse or 
standard keys on the keyboard: 
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<Tab>............................. move to next field, 

<Shift><Tab>................. move to previous filed, 

<End> ............................ move to end of field, 

<Home> ......................... move to beginning of field, 

Left arrow <←>................. move one character backward, 

Right arrow <→>............... move one character forward, 

<Backspace> .................. delete the character left of cursor, 

<Delete> ........................ delete the character right of cursor. 

8.1 Payment order – BN01 
Payment order BN01 is a common instrument of payment system 

replacing payment orders and cash payment slips. 

8.1.1 Entering a new order 

If you want to enter a new order, follow the instructions: 
  

Open the Order preparation folder by clicking Preparation in the left part of 
the window and then orders under it.  

 

Figure 61: Order preparation folder 

A list of payment orders will appear on the screen (it can be blank). 

1. Click Enter▲ with the left mouse button.   

2. Select Payment order from the menu. 
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Figure of the order (Figure 63) with already inscribed data (name, 
street, city, and orderer’s account number) appears on the screen. 
Besides the above mentioned data, suggested date of payment and 
deal type default codes are also automatically inscribed. The code 
must be corrected according to the payment details. The procedure is 
made easier by clicking the arrow on the right next to the code 
entering field that shows you all the permitted options in a combo box. 
Select the contents of the left part of the code first and then continue 
with the right. Register of Statistics Code which appears if you click the  
?  button on the right, next to the code entering fields, can help you. 
You can change the payment date but make sure not to backdate. 

 

Figure 62: Payment order BN01 

3. Enter your reference model and debit reference into the 
Reference fields. 

4. Enter sum of debit into the Currency field. 

5. Fill in the Payment details field. 

Instead of inscribing payment details, use shortcuts you have made 
beforehand. To do this, use the  ?  button on the right next to the 
Details field. Select a payment detail you have made beforehand from 
the list and click Select or deselect it by clicking Cancel. The 
procedure for creating shortcuts is described in chapter Occasional 
tasks. 

6. Enter the first or some of the first letters of beneficiary’s name 
into the field Name.  

Then the Address book of beneficiaries and their accounts appears 
(Figure 64).  
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Figure 63: A window for selecting beneficiaries and their accounts. 
 

By entering the first part of the name into the Beneficiary name field 
you limit the list of shown beneficiaries. Select a desired beneficiary by 
using the mouse and scroll box on the right.  If the beneficiary has 
more accounts, select the suitable one from the list Beneficiary’s 
accounts. The name of the selected beneficiary and his account 
number are presented inversely. Confirm your selection by clicking 
Select. The program will copy the data of the selected beneficiary and 
his account into suitable fields on the lower part of the order.  

If there is no beneficiary name in the Address book corresponding to 
the inserted string of letters, the list is empty. After clicking Add>> 
(right to the list of beneficiaries), a dialog box will appear enabling you 
to enter the data of a new beneficiary.  After entering beneficiary’s 
data, enter his account data.  

The Address book can be modified as you enter orders or you can 
enter data of beneficiaries and their accounts into the Address book 
beforehand. Detailed information about entering data into the Address 
book can be found in chapter Occasional Tasks. 

7. In case you do not fill in the Beneficiary Name field, you can 
select a beneficiary by means of the Account Number field. Enter 
the first or some of the first numbers of the account. 

Then the Address book of beneficiaries and their accounts appears 
(Figure 65). The use of Address book as well as selection and 
modification of beneficiaries are described in number 6 above. 
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Figure 64: Window for selecting an account and beneficiary 

8. Enter reference model and credit reference into the Beneficiary 
Reference fields. 

9. If you wish to process the order with priority, mark it as urgent. 
Click the box next to Urgent orders. There appears a tick in the 
box. Such an order is marked by U. 

10. When you have finished filling in the fields, click OK. Order data 
will copy themselves into the Preparation Orders folder. The 
last order is added to the list of prepared orders while a dialog 
box with a picture of a new order is ready for entering data of 
the next payment order.  To cancel the entry, click Cancel and 
to print it click Print.  

If you have not filled in all the necessary fields or you have 
entered a forbidden value into a field, you will be alerted by the 
program. A payment order can be saved into the list of orders 
despite data deficiency. It will be colored blue, with the WITH 
ERROR status and a question mark. Such an order cannot be 
included in a batch and sent to the bank. It must be repaired 
first. 

If all the data are filled in the order correctly, funds will be 
transferred to the beneficiary fast and correctly. Before you can send 
the order to the bank, you have to form it into a batch which has to be 
signed by one or more responsible people. 
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8.2 Compensation BN01 
Compensation is an instrument dating back to the old payment 

system. It is intended to report the data of compensation. 

8.2.1 Entry of a compensation 

If you want to enter a new compensation order, follow the 
instructions:  

1. Open the Order preparation folder by clicking Preparation in the 
left part of the window and then orders under it. 

  
 

  

A list of payment orders (Figure 62) will appear on the screen (it can be blank). 

2. Click Enter▲ with the left mouse button.  

3. Select Compensation from the menu. 

Figure of a compensation form with already inscribed data appears.  
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Figure 65: Compensation 

When filling in the compensation form, follow the instructions for 
payment order entry. Detailed information about filling in certain fields 
are in section 8.1.1 Entry of a new order. With compensation Orderer 
and Beneficiary are the same. 

8.3 Special payment slip 
Special payment slip is designed to settle monthly liabilities, for 

example various subscriptions, tuition fees, and services. 

8.3.1 Entry of a new special payment slip 

If you want to enter a new special payment slip, follow the 
instructions:  

1. Open the Order preparation folder by clicking Preparation in the 
left part of the window and then orders under it.  

A list of payment orders will appear on the screen (it can be blank). 

2. Click Enter▲ with the left mouse button.  

3. Select Special payment slip from the menu. 

Figure of a special payment slip form with already inscribed data 
appears.  
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Figure 66: Special payment slip 

When filling in a special payment slip, follow the instructions for 
payment order entry.  Detailed information about filling in certain fields 
are in section 8.1.1 Entry of a new order. When you modify the 
contents in the Name or Account fields on the Beneficiary side, 
Address book of beneficiaries and their accounts appears. Selection of 
a beneficiary and his account from the address book is done in the 
same way as described in step 6 of payment order section. The 
program will copy the data of the selected beneficiary and his account 
into the suitable fields on the beneficiary’s side.When transferring 
data from the address book into the special payment slip, the 
data about credit reference will not be transferred even if they 
are recorded in the address book. 

Account owners above all will probably wish to transfer the data from 
the special payment slip into the payment order BN01, because by 
doing so they also have an option of debit reference entry. Enter the 
following fields into suitable fields on the Payment order BN01: paying 
details, name, beneficiary’s account number and the amount of 
payment. All data cannot be entered because information about credit 
reference model is missing as it is not specified on the special payment 
slip. Use credit reference model 12. Enter reference exactly as it is 
specified on the special payment slip. 

 

8.4 Using order templates 
Hal E-Bank enables use of templates – sample orders that were 

prepared in advance. Templates are the means for reusing orders, so 
that the user does not need to fill in a payment order each time with the 
same or similar data. 
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8.4.1 Exporting templates 

You can export a group of orders as samples that can be used as 
templates and filled in. You can export orders as templates either from 
the Preparation/orders folder or Archive/orders folder. 

8.4.1.1 Exporting templates from folder Preparation/orders 

You can export templates from folder Preparation/orders by 
following procedure: 

1. Open the Preparation/orders folder. In the left part of the 
window click with a left mouse button on Preparation and 
then Orders. 

A list of payment orders are displayed on the screen. 

2. Search for the orders you want to export as templates and 
select them. 

3. Click (Im/Ex)port and then select the Export templates 
option from the menu. 

A dialog window opens for entry of the template's text file name 
into which the selected orders will be saved to. 

4. Fill in the name of the (group of) templates and confirm the 
export by clicking OK or discard it by clicking Cancel. 

After successful export a message appears stating the number of 
exported samples. 

5. Confirm the message by clicking OK. 

If you choose a name of the file that already exist new information 
will overwrite the old information in the file. 

8.4.1.2 Exporting templates from folder Archive/orders 

You can export templates from folder Archive/orders by 
following procedure: 

1. Open the Archive/orders folder. In the left part of the 
window click with a left mouse button on Archive and then 
Orders. 

A list of archived orders is displayed on the screen. 

2. Search for the orders you want to export as templates and 
select them. 

3. Click (Im/Ex)port and then select the Export templates 
option from the menu. 

A dialog window opens for entry of the template's text file name 
into which the selected orders will be saved to. 

4. Fill in the name of the (group of) templates and confirm the 
export by clicking OK or discard it by clicking Cancel. 

After successful export a message appears stating the number of 
exported samples. 
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5. Confirm the message by clicking OK. 

8.4.2 Importing templates 

You can import a (group of) sample order(s) by following the procedure 
described below. 

1. Open the Preparation/orders folder. In the left part of the 
window click with a left mouse button on Preparation and then 
Orders. 

On the screen you should see a list of payment 
orders.  

2. Click (Im/Ex)port and then select the 
Import samples option from the menu. 

 
A dialog window opens for selecting a template to 

be imported. 

1. Select a (group of) desired templates for import by clicking it. 

2. Confirm the import by clicking OK, otherwise click Cancel. 

After successful import a message appears stating the number of 
imported templates. 

3. Confirm the message by clicking OK. 

Just imported templates of payment orders appear in the screen in 
purple color. If you do not see the imported template then probably you 
have to remove the filter. 

When you edit an imported order template, which is in a purple color, 
and than close it by confirming changes (click OK button) it becomes a 
normal prepared payment order. 

You may wish to change value date of several orders at the same time, 
as described in section 1.1.5. 

8.5 Modifying a payment order 
Payment order can be corrected or modified if it has not yet been sent 

to the bank to be realized. Signed orders can not be modified, if they are 
not unsigned beforehand. The orders can be unsigned only by an 
authorized person with authorization for right-side signing. 

If you want to modify data in a payment order, do the following: 

1. Open Preparation/orders folder in the left part of the window, 
by clicking on Preparation and then Orders. 

2. Search for the order you wish to modify and click on it. 

If the list contains so many prepared orders, that it is not possible for 
all of them to be displayed on one screen, you can use the slider bar on 
the right edge of the sub window with orders to search for it. The slider 
bar is displayed only if the number of orders exceeds one page. 

3. Click the button Open or double-click the selected order to open it. 
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4. Click in the field you wish to modify and enter the value or text 
into the field. 

To change any other field repeat step 4. When you are satisfied with the 
contents of the order displayed in the window, click the button OK. If you 
wish to discard the changes and keep the original order, click Cancel or 
press the <Esc> key. 

8.5.1 Changing value date of multiple orders 

You can change value date of multiple orders.. 

You could change value date only for orders than weren't sent to the 
bank for realization. If payment order with value date in the future was 
already sent to the bank, should be cancelled first. If that order isn't 
realized yet and cancellation was successful, you should duplicate it from 
the archive and changes the value date, sign it and send to the bank. 

Signed orders can not be modified, if they are not unsigned beforehand. 
The orders can be unsigned only by an authorized person with 
authorization for right-side signing. 

If you want to change value date of payment order or several payment 
orders simultaneously, do the following: 

1. Open Preparation/orders folder in the left part of the window, 
by clicking on Preparation and then Orders. 

 A list of payment orders is displayed. 

2. Look for the order you want to 
delete and click on it with the left 
mouse button. The selected order 
has to be highlighted. Only in that 
case it is selected 

3. With a left mouse button click on Other and then on Value 
date change option from the menu. 

4. Enter a date and confirm it on OK button or press <Enter> key. 

8.5.2 Transferring orders on a different account 

If you want to transfer one or more orders from one account to 
another, use the following procedure: 

1. Open Preparation/orders folder in the left part of the window, 
by clicking on Preparation and then Orders. 

 A list of payment orders is displayed. 

2. Select orders you want to move. 
Selected orders have to be 
highlighted. 

3. Click on the Other button and then 
select option Transfer on a different account. 

A list of accounts, according to your authorizations, will be displayed. 

4. Select account on which you want to transfer orders and click on 
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the OK button. 
Selected orders will be transferred on selected account.  

8.6 Deleting a payment order 
If you wish to delete the order from the list of prepared orders, do the 

following: 

1. Open Preparation/orders folder in the left part of the window, by 
clicking on Preparation and then Orders. 

A list of payment orders is displayed.  

2. Look for the order you want to delete and click on it with the left 
mouse button. The selected order has to be highlighted. Only in 
that case it is selected 

3. With a left mouse button click Delete or press the <Delete> key 

4. Confirm the deletion with Yes, if you want to delete payment 
orders, otherwise click NO. 

Selected orders will be deleted from the list of prepared orders. 

When you delete a payment order you can no longer bring it 
back. Because of that make sure that you really want to delete 
the selected order. 

Signed orders can not be modified. If you want to modify information in 
an already signed order, you have to unsign it first 

8.7 Archive of orders 
Sent orders, batches, and messages can be seen in the Archive folder. 

Archived documents can be previewed and printed. Archived orders can 
also be exported or duplicated.  

Sent orders could be seen in the Archive/orders folder. Archived 
orders can be previewed and printed. Sent orders with value date in the 
future, that wasn't realized yet, could be cancelled. Archived orders could 
be reused, exported or exported as template. 

If you can't find the orders you wanted to see in Archive/orders folder, 
perhaps you have not selected the right time period to display the 
documents. 

8.7.1 Reviewing archived documents 

To review archived documents follow this procedure: 

1. In the left part of the window click on Archive and then on 
Orders. 

2. Look for a wanted order and then click on it with a left mouse 
button. 
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If you can't find the document you wanted to see perhaps you have 
not selected the right time period to display the documents. 

3. To see details of the archived document open it by clicking Open 
or simply double-click it. 

Order data will be displayed on the screen. To close it simply click 
Close. 

8.7.2 Exporting payment orders as templates from 
Archive/orders folder 

To export archived orders and reuse them for creating new ones, use 
the following procedure. 

1. In the left part of the window click on Archive and then on 
Orders. 

2. Select orders you want to export. 

3. Click on Export and then click on Export templates option from 
the menu. 

A dialog window opens for entry of the template's name into which 
the selected orders will be saved to. 

Confirm export by clicking OK button. After export is finished a 
message with export details will be shown. To close message click the 
OK button. 

8.7.3 Duplicating archived orders 

 To prepare a new order with the same data as found in the archived 
order, follow this procedure: 

1. In the left part of the window click on Archive and then on 
Orders. 

2. Look for a wanted order and then click on it with a left mouse 
button. 

You can also select several orders simultaneously. 

3. With a left mouse button click Duplicate. 

Duplicated orders are shown in the Preparation/orders folder. 

8.7.4 Cancellation of sent orders 

You could cancel only sent orders with value date in the future. 

To cancel archived order with status "sent" and value date in the 
future, use the following procedure: 

1. In the left part of the window click on Archive and then on 
Orders. 

2. Look for a wanted order and then click on it with a left mouse 
button. 
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You can also select several orders simultaneously. 

3. With a left mouse button click on the Cancellation button. 

4. You must confirm cancellation of every single order by clicking 
Yes button. 

5. Enter your (PIN) number and click on OK button or simply press 
<Enter> key. 

The Hal E-Bank establishes a connection with the bank's server and 
sends a request for orders cancelling. Note about successfully or 
unsuccessfully cancellation will be shown in Review/Transactions 
folder after next refresh of contents. 

Successfully cancelled orders get status unsigned.  

8.7.5 Deleting archived orders 

If you wish to delete orders from the list of archived orders, do the 
following: 

1. In the left part of the window click on Archive and then on 
Orders. 

It displays list of archived payment orders. 

2. Look for a wanted order and then click on it with a left mouse 
button. 

You can also select several orders simultaneously. 

3. Click on Delete button. 

4. Confirm the deletion with Yes, otherwise click No. 

The selected orders will be deleted from the list of archived orders. 

By deleting orders you do not unsign them. If you want to unsign 
orders select them and then click on Unsign. When you delete 
payment orders you can no longer bring it back. Because of that make 
sure that you really want to delete them. 

8.8 Resending rejected orders 
Rejected order can be sent again to be realized. A rejection may occur if 

your account does not hold enough funds or for some other reason. Every 
payment order is assigned a unique unchangeable number when being 
prepared. For this reason, an rejected payment order can not be 
immediately signed and resent, but has to be duplicated first.  The 
duplicated payment order is then assigned a new unique number, can be 
edited, signed, and sent to your bank. 
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9 Signing orders and batches 

Before you send a payment order to the bank, it must be signed by one or 
more authorized persons with adequate authorization for signing payment 
orders. 

There are two ways to sign orders. First way is individual, which means 
that you can sign each order individually. Other way is batches, which 
means that you form orders into batch, and then you work with a batch 
orders and not with individual orders.  

Which way you’ll choose it depends on your bank? Authorization depends 
of each account. If account has authorization for batch preparation, then 
second way is needed, other first way.  

9.1 Individual processing of payment orders 

9.1.1 Signing prepared orders 

To sign prepared payment orders, do the following: 

1. Open Preparation/orders folder in the left part of the window, 
click on Preparation and then on Orders.   

A list of payment orders is displayed. Prepared orders without errors, 
the one that you can sign, are in green colour.  

2. Look for the order you want to sign and click it with a left mouse 
button. The selected order has to be highlighted. Only in this 
case it is selected. 

You can mark several orders and sign them in group or each one 
separately. Procedure of signing one selected order is explained in the 
following text. If you have chosen multiple orders, see the description 
of the procedure in Section 9.1.4. 

3. Left-click the selected order and choose Sign from the menu. 

The selected order is displayed on the screen. Before confirming 
signing you can change information in the form that is not greyed out. 

4. Signing is confirmed by clicking OK. If you do not want to sign 
the selected order, click Cancel or press the <Esc> key. 

Signed payment orders will change the colour to red in the 
Preparation/order folder and can be sent to the bank to be realized. 

Signed orders can not be modified. If you want to modify 
information in an already signed order, you have to unsign it 
first. See Section 9.1.3  

9.1.2 Singing prepared orders in Hal E-Bank/Web 

Signed orders that are successfully sent to remote signing can be 
seen in application Hal E-Bank/Web in window Signing of payment 
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orders, as it was shown in next figure. 

 

Figure 67: Payment orders in remote singing 

This window is intended for reviewing orders within Hal E-Bank 
system, which waiting for final signing. If you are working with several 
accounts, from drop-down list Account, choose account that you want 
to review orders for.  

Unsigned orders are displayed in a table with following information: 

1. Value date,  

2. Receiver,  

3. Amount,  

4. Control amount,  

5. Purpose of payment 

If the list of orders is bigger than one page, there are links on the top 
of the table for previous and next page. Sum of amounts (for current 
page) is displayed at the bottom of the table.  

If you want to sign order click on reference field Select in the right 
column or use button Select all. Sign order by clicking on Sign. 

Order that is not signed could be returned back. By clicking Return 
to preparation button, order returns to the client, from which was 
sent to remote signing. Order will be in the Preparation/order folder. 
Returned order has same signatures as it has before sending on 
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remote signing. When receiving documents from the bank in the client 
you also receive information about returned orders, as it is shown in 
the figure below. 

 

Figure 68: Returned documents 

9.1.3 Unsigning the orders 

When authorized person signs a payment order, information of the 
order can no longer be changed. You can change the information only 
if the authorized person unsigns the order first. To unsign a signed 
payment order, do the following: 

1. Open Preparation/orders folder in the left part of the window, 
click on Preparation and then on Orders.  

A list of payment orders is displayed. Signed orders, the ones that 
you can unsign, are displayed in red colour. 

2. Search for the order you want to unsign and click it. The selected 
order has to be highlighted. Only in this case it is selected. 

You can mark several orders at the same time, and unsign them at 
the same time.  

3. Left-click the selected order and choose Unsign from the menu. 

If you want to choose multiple orders, see Section 9.1.4. 

Unsigned orders will be displayed in green colour, with status 
“PREPARED”. In green colour are displayed prepared orders, which 
need to be signed. If order has currency date older than current date, 
order will be displayed in a blue colour with a status “WITH ERROR”. 

9.1.4 Collectively signing of orders 

To sign several orders at the same time, do the following: 

1. Open Preparation/orders folder in the left part of the window, 
click on Preparation and then on Orders. 
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A list of payment orders is displayed. Signed orders, the ones without 
any error, are displayed in green colour. 

2. Search for the orders you want to sign, displayed in green 
colour, and select them. If you don’t know how to select 
multiple orders, see Section How to mark multiple lines. 

3. Left-click the selected order and choose Sign from the menu. 

A window as in figure below opens with of information about the 
number of selected orders and their type.  

 

Figure 69: Collectively signing of orders 

Click Details for more information on the orders selected. You can 
exit details by clicking Back>>. 

If you do not want to sign the selected order, click Cancel or press 
the <Esc> key. 

If you want to sign all selected orders, just click on button All. 

You can review and modify orders before signing them by 
clicking Individually. In that case you must confirm or cancel 
signing of each order by clicking the button OK or Cancel. 

9.1.5 Collectively unsigning of orders 

To unsign several signed orders at the same time, do the following: 

1. Open Preparation/orders folder in the left part of the window, 
click on Preparation and then on Orders. 

A list of payment orders is displayed. Signed orders, the ones that 
you can unsign, are displayed in red colour. 
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2. Search for the orders you want to sign, displayed in red colour, 
and select them.  

3. Left-click the selected orders and choose Unsign from the menu. 

 

Figure 70: Collectively unsigning of orders 

A Collectively unsigning of orders window is displayed on the 
screen. 

Click Details for more information on the orders selected. You can 
exit details by clicking Back>>. If you want to cancel unsigning the 
selected order, click Cancel or press the <Esc> key. If you want to 
unsign all selected orders, just click on button All. 

9.1.6 Sending a payment orders to remote signing 

Signing payment orders of payment orders requires one of six 
signatures defined for each account separately. How many signatures 
and of what kind are required for signing a payment orders is 
displayed in the Order signing window, which opens when you 
signing a payment orders. Which signatures can be assured by single 
user depend on his signature category. About authorization and 
signing categories you can learn more in a section Hal E-Bank 
authorization system. In general you first have to provide all left-side 
signatures and then all the right-side ones. 

To send prepared payment orders to remote signing, do the 
following: 

1. Open the Preparation/orders folder in the left part of the 
windows, by clicking on Preparation and then on Orders. 

A list of payment orders is displayed. 

2. Search for the payment orders displayed in 
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a green colour with status “PREPARED” and click on it with a left 
mouse button. The selected payment order has to be highlighted. 
Only in that case it is selected. 

3. Click on Other button and then click on Send in signing button 
from the menu. 

9.2 Batch processing of payment orders 
When payment orders are prepared you first have to form a batch of 

orders before you can sign them and send them to the bank. In order to 
form a batch, sign it, and send it, you need the appropriate authorization. 

9.2.1 Forming payment order into batch 

Open the Preparation/orders folder. Orders that you want to put in 
a batch must be without errors: indicated in green colour, having a 
status "Prepared". Choose one or several orders and click Into Batch. 

A window as in figure 1 is displayed. If you want to sign a group of 
orders without individual review click All, otherwise click Individually. 

New batch creation dialog box will be shown, containing information 
about batch. Before you confirm forming orders into batch, you could 
sign a reference on batch. Forming batch confirm with OK or cancel 
with Cancel button or <Esc> key. 

In this step batch can be partially or finally signed. That depends on 
number of left and right signers and on signature category of 
authorized person that forming batch. 

After forming orders into batch, selected orders will be removed from 
Preparation/orders folder and formed batch of orders will be sent to 
Preparation/Batches folder.  

Colours of batch in Preparation folder could be: 

Colour of batch in 
Preparation folder 

Status of batch Description in “Status” 
column 

Green Prepared batch PREPARED 

Red Signed batch CHECKED 

Purple Batch sent on remote 
signing 

ON REMOTE SIGNING 

Purple Batch returned from 
remote signing 

RETURNED FROM REMOTE 
SIGNING 

Grey 
Batch sent on remote 
signing without 
confirmation 

ON REMOTE SIGNING 
WITHOUT CONFIRMATION 

9.2.2 Unbinding a batch of orders 

When the batch is formed, you can’t change orders data. You can 
change orders data only when you unbind batch. If you want to unbind 
batch, do the following  
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1. Open the Preparation/batches folder in the left part of the 
window, by clicking on Preparation and then on Batches.  

A list of batches is displayed on the screen. 

Search for the batch displayed in a green colour with status 
“PREPARED” and click on it with a left mouse button. The selected 
order has to be highlighted. Only in that case it is selected. 

2. With a left mouse button click on Unbind. 

Window with batch data displays on the screen. If you want to unbind 
batch, click on OK. Orders from batch will be shown in the folder 
Preparation/orders, and batch will be sent to folder 
Archive/batches having status “BROKEN” is in the folder. 

9.2.3 Excluding orders from batch  

Single order can be excluded from the batch:  

6.  Open the Preparation/batches folder in the left part of the 
windows, by clicking on Preparation and then on Batches. 

A list of batches is displayed. 

7.  Search for the batch displayed in a green colour with status 
“PREPARED” and click on it with a left mouse button. The selected 
order has to be highlighted. Only in that case it is selected. 

8. With a left mouse button click on Exclude. 

A list of information about batch is displayed on the screen. 

9. With a left mouse button click on List of orders in a batch. 

A list of orders in a batch is displayed on the screen. 

10. Select one or several orders and click on Exclude button. 

Selected orders move from the list of included orders to a list of 
excluded orders. You can choose between lists of included or excluded 
orders. You can include or exclude orders from the batch by clicking on 
Include or Exclude button. By clicking the OK button you get back in a 
window with batch information and excluded orders. Excluding orders 
you can finally confirm with OK, or cancel with Cancel button or 
<Esc> key. Excluded orders are moved to Preparation/Orders 
folder. 

9.2.4 Signing batches 

Signing a batch of payment orders requires one of six signatures 
defined for each account separately. How many signatures and of what 
kind are required for signing a batch is displayed in the Batch signing 
window, which opens when you signing a batch. Which signatures can 
be assured by single user depend on his signature category. About 
authorization and signing categories you can learn more in a section 
Hal E-Bank authorization system. In general you first have to provide 
all left-side signatures and then all the right-side ones. 
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When you want to sign prepared batches, do the following: 

1. Open the Preparation/batches folder in the left part of the 
windows, by clicking on Preparation and then on Batches. 

A list of batches is displayed. 

2. Search for the batch displayed in a green colour with status 
“PREPARED” and click on it with a left mouse button. The selected 
order has to be highlighted. Only in that case it is selected. 

3. With a left mouse button click on Sign. 

A list of information about batch is displayed on the screen. Before 
confirmation of signing you can review orders from a batch. 

4. If you want to sign a batch, confirm it with Sign. If you don’t want 
to sign it, click on Cancel or <Esc> key. 

Batch that has all required signatures is displayed in a red colour with 
status “PREPARED”. It can be sent to the bank. Sending a batch to the 
bank, see in Section Sending and receiving documents. 

9.2.5 Signing a batch in Hal E-Bank/Web 

Batches of paying orders which are successfully sent to remote 
signing, it could be seen in an application Hal E-Bank/Web in a window 
Signing batches (Figure 71) 

 

Figure 72: Signing batches in Hal E-Bank/Web 

This window is intended for reviewing batches within Hal E-Bank 
system, which waiting for final signing. If you are working with several 
accounts, from drop-down list Account, choose account that you want 
to review batches for.  

Unsigned batches are displayed in a table with following information: 
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• Creation date,  

• Document type,  

• Number of payment orders,  

• Control sum,  

• Status and 

• Reference. 

If the list of orders is bigger than one page, there are links on the top 
of the table for previous and next page. Sum of amounts (for current 
page) is displayed at the bottom of the table.  

If you want to sign batch click on reference field or on  icon, in the 
right column (signing). 

Window Data on batch is used for reviewing batches data, where we 
can finally sign the batch. In the right corner of the window following 
batches data are displayed: 

• Batch reference, 

• Batch ID,  

• On debit of account,  

• Order type in batch,  

• Number of payment orders in batch,  

• Checksum,  

• Creator of batch,  

• Batch creation date, 

• Batch status and  

• Status change time. 
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Figure 73: Batches data in Hal E-Bank/Web 

The batch subscribers are displayed under the batch data. There are 
left signers on the left side, and right signers on the right. Along the 
name of a subscriber it is displayed his category. If signature isn’t 
needed there is a sign »X«, if it’s needed then »?«. 

Batch that is not finally signed could be returned back. Sign batch by 
clicking on Sign, in accordance with a signature category. 

By clicking Return to preparation button, batch returns to the 
client, from which was sent to remote signing. Batch will be in the 
Preparation/Batches folder. Returned batch has same signatures as 
it has before sending on remote signing. When receiving documents 
from the bank in the client you also receive information about returned 
batch, as it is shown in the figure below. 

 

Figure 74: Returned documents 

To see orders in the batch, click on the List of payment orders in 
the batch, at the bottom of the page. Click on the Back to back on 
the previous screen. 
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9.2.6 Unsigning a batch 

When authorized person signs batch, orders could not be excluded 
and batch could not be unbind unless it is unsigned first. If you want to 
unsign batch, do the following:  

1.  Open the Preparation/batches folder in the left part of the 
windows, by clicking on Preparation and then on Batches. 

A list of batches is displayed. 

2. Search for the batch displayed in a red colour with status 
“CHECKED” and click on it with a left mouse button. The selected 
batch has to be highlighted. Only in that case it is selected. 

3. With a left mouse button click on Unsign button. 

Unsigned batch is displayed in a green colour, with status 
“PREPARED”. 

9.2.7 Reviewing batches and orders in a batch 

In a folder Preparation/Batches you can choose either to see 
batches or orders in a batch. You can choose it by clicking on Other 
button, choose option View and then choose between Batches or 
Orders. 

In both examples you can review 
single batch or order. You can do that 
by choosing batch or order from a list 
and click on Open button. If you chose 
batch, it displayed a window with 
information about batch. By clicking 
List of orders in a batch you can open a 
list of orders, where you can review 
orders. If you chose order, it displayed a window with a chosen order. 

9.2.8 Transferring a batch on other account 

If you want to pay one or several batches from other account you can 
transfer them by following procedure: 

1. Open the Preparation/batches folder in the left part of the 
windows, by clicking on Preparation and then on Batches. 

A list of batches is displayed. 

2. Search for the batch click on it with a left mouse button. 

3. Click on Other button and then on Transfer on a different 
account button in the menu. 

A list of accounts for which you have authorization is displayed. 

4. From the list choose an account from which you want to pay and 
confirm it by clicking on OK button. 

It will transfer the chosen batch on selected account. 
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9.2.9 Reviewing archived batches 

In a folder Archive/batches are displayed information about sent 
and unsigned batches. 

In a list choose a batch and click on Open button. It opens a window 
with batch information. By clicking Orders in the batch button, you 
can open a list of orders which can be reviewed. 

9.2.10 Deleting a batch 

You can delete batches from a folder Preparation/batches only if 
they are not signed yet. Signed batches, which you want to delete, 
first unsign. In a folder Archive/batches you can delete all batches. 

Select the batch you want to delete (in a folder Preparation or 
Archive), select it and click on Delete button. It displays a window 
with information if you shore that you wished to delete selected batch. 
If you click on Yes, it will delete batch without additional warning and 
remove it from folder. 

Batches are permanently deleted so you should be very careful. 

9.2.11 Sending a batch to the bank 

Signed batches could be found in a folder Delivery, where they are 
waiting to be send to the bank. Sending documents to the bank was 
described in a Section Sending and receiving documents. 

Successfully send batches are moved from folder 
Preparation/Batches to Archive/Batches folder, and removed 
from Delivery folder. 

9.2.12 Sending a batch to remote signing 

Signing a batch of payment orders requires one of six signatures 
defined for each account separately. How many signatures and of what 
kind are required for signing a batch is displayed in the Batch signing 
window, which opens when you signing a batch. Which signatures can 
be assured by single user depend on his signature category. About 
authorization and signing categories you can learn more in a section 
Hal E-Bank authorization system. In general you first have to provide 
all left-side signatures and then all the right-side ones. 

To send prepared batches to remote signing, do the following: 

4. Open the Preparation/batches folder in the left part of the 
windows, by clicking on Preparation and then on Batches. 

A list of batches is displayed. 

5. Search for the batch displayed in 
a green colour with status 
“PREPARED” and click on it with a 
left mouse button. The selected 
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batch has to be highlighted. Only in that case it is selected. 

6. Click on Other button and then click on Send in signing button 
from the menu. 
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10 Files * 

*All banks does not support file exchange. In that case this functionality is 
invisible or inactive in the application. 

Program Hal E-Bank provides file exchanging between bank and client. 
Bank defines type of file for exchanging. 

10.1 Preparing files 

10.1.1 Entering new file 

To enter new file use the following procedure:  

1. Open Preparation/Files folder in the left part of the window. A 
list of prepared files is displayed (can be empty). 

2. Click the Enter button.  

3. Select type of file to enter from the menu. If menu is empty, 
code file missing. In the case try to refresh contents. A standard 
dialog box (Enter) is displayed, which requires from you to select 
the name of the file to be imported. 

4. Search for the file you wish to import. Confirm the choice by 
clicking the <Enter> key, or click Open.  

When process of importing is finished, message with information 
about number of imported files is displayed. Confirm import by clicking 
Ok button, and imported files will be shown in the list. 

10.1.2 Deleting files 

To delete file select it from the list and use following procedure: 

1. Select the Preparation/Files folder. List of files will be shown. 

2. Select file you want to delete. Selected file has to be highlighted. 

3. Click on the Delete button. 

4. Confirm deletion by clicking Yes. To cancel deletion click No. 

5. Selected file will be deleted from the list of files.  

6. Signed files cannot be deleted. They have to be unsigned first. 

10.1.3 Signing and unsigning files 

A file has to be signed by an authorized person, with proper signing 
authorization, before you can send it to the bank for realization. The 
authorization is connected to the security smart card. 
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10.1.3.1 Signing files 

To sign file use the following procedure: 

1. Select the Preparation/Files folder.  

List of files will be shown. Only files with the status "prepared" can 
be signed, and they are shown in the green colour. 

2. Select file you want to sign. Selected file has to be highlighted. 

3. Click on the Sign button. 

Message with statistical information about file will be shown. 

4. Signing is confirmed by clicking OK. If you do not want to sign 
the selected order, click Cancel or press the <Esc> key.  

Signed files are shown in the list in red colour. Only signed files 
can be sent to bank for realization. 

10.1.3.2 Unsigning files 

When an authorized person signs a payment order, information of 
the order can no longer be changed. You can change the information 
only if the authorized person unsign the order first. 

To unsign file use the following procedure: 

1. Select the Preparation/Files folder. 

List of files will be shown. Signed files are in the red colour. 

2. Select file you want to unsign. Selected file has to be highlighted. 

3. Click on the Unsign button. 

Unsigned file will be shown in the list in green colour with status 
"prepared". 

10.2 Sending files 
Signed files are waiting in the Delivery folder to be sent to the bank. 

Sending documents is explained in section Exchanging documents 
with the bank. 

Successfully sent files are moved from the Preparation/Files folder to 
the Archive/Files folder. They are also removed from the Delivery 
folder. 

10.3 Reviewing sent files 
All information, about files that are successfully sent to bank for 

realization, will be shown in the Review/Files folder. To see a list of files 
do the following: 

1. Select the Review/Files folder. 
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The list of files will be shown for the time period specified by the filter 
above. 

2. To see statistical information for the file select it from the list, and 
click on the Open button.  If file is readable window with basic 
information about file will be displayed. To see content of file click on 
the Preview button. 

3. To export file click on the Export button. The Save as dialog box 
shows up for entering the name of the file to be saved. To finish 
export click on the Save button. 

4. Selected file delete by clicking on the Delete button. Confirm deletion 
by clicking Yes. 

10.4 Archived files 
Sent files can be seen in the Archive/Files folder. To see list of 

archived files do the following: 

1. Select the Archive/Files folder. The list of files will be shown for the 
time period specified by the filter above. 

2. To see statistical information for the file select it from the list, and click 
on the Open button.  If file is readable window with basic information 
about file will be displayed. To see content of file click on the Preview 
button. 

3. To export file click on the Export button. The Save as dialog box shows 
up for entering the name of the file to be saved. To finish export click on 
the Save button. 

Selected file delete by clicking on the Delete button. Confirm deletion by 
clicking Yes. 
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11 Messages 

Messages are intended for communication between the user of Hal E-Bank 
and the bank. The bank employee in charge of your account will send 
answers to your messages, which you will find in the Deliver folder. 

11.1 Preparing a new message 
To prepare a new message for the bank employee. in charge of your 

account, do the following:  

1. Open Preparation/messages folder. A list of messages is 
displayed (it can be empty) to which you can add new messages 
or delete them. 

2. Click Enter in the command bar and select Message.  

The Getting the note ready for the bank referee window is 
displayed on the screen: 

 

Figure 75: Getting the note ready for the bank referee 

3. Enter a short message name in the Subject line. 

4. Click in the Contents field below or press the <Tab> key. After 
writing the content if you press <Enter> or button OK, 
application could display error message. 

5. Write the contents of the message. Message length is limited. 
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6. Click OK. 

All prepared messages are displayed in the Preparation/Messages folder 
in black with status "PREPARED". At the same time, they will be added to 
the Delivery folder. The message has not yet been sent to the bank. 

Prepared message can be corrected before sending them. Do this by 
opening the message you wish to correct by double clicking it or select it, 
click Open and follow the instructions above. Once you have sent the 
message to the bank, you can no longer change it. 

 If you want to delete message, open the Preparation/Messages 
folder in the left part of the main window, look for the message you want 
to delete and click on it with the left mouse button, click Delete or press 
the <Delete> key. Click Yes to confirm or No to cancel. 

Once you have sent the message to your bank, you can no longer 
change it. If you want to see its content, click on the Archive 
group of folders then select the message and click open or simply 
double-click it.  

Other than messages you can send complaints or requests for 
receipt to the bank employee. 

11.1.1 Preparing a complaint 

If you wish to make a new complaint: 

1. Open the Message preparation folder by clicking Preparation in 
the left part of the window and then messages under it. 

2. Click Enter and then Complaint. 

A new dialog box Complaint (Figure 76) appears on the screen.  

 

Figure 76: Complaint 
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3. In the Account number field select the account to which the 
complaint refers. 

4. Account owner details are transferred into the Account owner field. 

5. By means of a mouse select one of four types of complaint. 

6. The contents of the entry window depend on the type of complaint 
you have selected. After having selected a type of complaint, enter 
also (on the right next to the type of complaint sign): 

•  if you have selected A photocopy of a received inflow or Inquiry 
on expected inflow, enter payment date and orderer’s account, 

• If you have selected Statement Complaint or Other, enter 
statement date and select a reason for your complaint. 

7. Enter the amount you are complaining about into the Amount field. 

8. Select how you would like to receive the bank’s answer to your 
complaint.  

9.  If you have selected a telephone or fax notification in step 7, enter 
the telephone number to which you would like to receive the 
answer. 

10.  After entering all the data, click OK. 

The complaint you have entered will be shown in red on the list of 
prepared messages. It will also be added to the delivery list in black.  

A complaint can be corrected or deleted as described for a common 
message. 

11.1.2 Preparing a request for receipt   

If you wish to make a new request for receipt: 

1. Open the Message preparation folder by clicking Preparation 
in the left part of the window and then messages under it. 

2. Click Enter and then Confirmationt. 

A new dialog box Confirmation appears on the screen. 
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Figure 77:  Confirmation 

3. In the Account number field select the account to which the 
receipt refers. 

4. Account owner details are transferred into the Account 
owner field. 

5. Enter Payment order ID, or click the Select order button and 
select an order from the list of sent orders that appears. You 
can modify the period of presented orders in the list of sent 
orders. 

6. Select how you would like to receive the receipt. 

7. If you have selected a fax notification in step 6, enter the 
number to which you would like to receive the receipt. 

8. After entering all the data, click OK. 

A request for confirmation will be presented on the list of prepared 
messages in green. It will also be added to the delivery list in black. 

Request for receipt can be corrected or deleted as described for a 
common message. 

11.1.3 Creating a form for gross payment of salaries 

Under the instructions on the notification of the DURS (Slovene Tax 
Agency) about the payment of salaries and other remunerations, the 
bank must ensure information on gross amount of paid salaries or 
bonuses for individual legal entity on the day of the payment of 
salaries and other remunerations. For this purpose the user of Hal E-
Bank electronic bank can enter data and send them to the bank for 
processing. 

If you wish to make a new form for payroll summary: 
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1. Open the Message preparation folder by clicking Preparation in 
the left part of the window and then messages under it. 

2. Click Enter and then OBR-PL. 

A new dialog box Payroll summary form (Figure 77) appears on 
the screen. 

 

Figure 78: Payroll summary form 

3. Enter all the required data and click OK. 

Introduced payroll summary form will be displayed on the list of 
prepared messages in blue. It will also be added to the delivery list in 
black. 

Payroll summary form can be corrected or deleted as described for a 
common message. 

11.2 Sending message to bank 
Prepared documents are in the Delivery folder where they are waiting 

to be sent to the bank. Sending documents to the bank is described in 
detail in the section Exchanging documents with the bank. 

Successfully sent documents are moved from Preparation/messages 
folder to Archive/messages folder and removed from Delivery folder.  

11.3 Reviewing archived message 
Sent messages can be seen in the Archive/messages folder. 

1. To see details of the archived document open it by clicking Open or 
simply double-click it. 
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2. Choose message you want to delete and click on it with the left 
mouse button, click Delete or press the <Delete> key. Click Yes 
to confirm or No to cancel. 
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12 Notices 

Bank notices are documents intended for electronic communication. They 
are prepared by a bank employee and sent to a Hal E-Bank user or to all 
users simultaneously.. 

12.1 Reviewing and deleting bank notices 
To review notices received, do the following procedure: 

1. With a left mouse button click on Review and then on Notices. On 
the screen is displayed the list of notices by time period. 

2. Open the notice you wish to read by selecting with the mouse or 
arrow keys and click Open. Alternatively, you can quickly open the 
notice by simply double-clicking it. 

3. Reviewed notice is highlighted with a symbol  

Selected notice can be deleted by clicking Delete button. Confirmation 
of deletion is needed, just click Yes and notice is deleted. 
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13 Document exchange with a bank 

There is two functions for exchanging documents with a bank: sending 
documents to the bank and receiving documents from the bank. When 
executing any of this functions data about authorized person and his 
authorizations will be refreshed also. At the same time while sending 
documents to the bank, user receives all documents prepared by the bank. 
While receiving documents from the bank user receives only documents 
that are assigned to him. 

13.1 Settings 
During sending documents to the bank you can receive all documents 

that bank prepared for you. You have three options to choose:  

• I want to refresh the data for all my accounts, 

• I want to refresh the data only for active account, 

• I don’t want to refresh the data on my account. 

If you want to choose any of these options, do the following:  

1. Click on Settings button in a toolbar or use Settings command 
from Tools menu. 

 

2. Choose TCP/IP list. 

3. In a sub window Delivery choose wanted option. 

4. You can close window by clicking OK. 
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Figure 79: Settings - Delivery 

13.2 Sending documents to the bank 
All documents (packages with orders, messages) which are prepared for 

sending to the bank are in Delivery folder. 

1. If you work with several accounts, choose the one from which you 
want to send documents to the bank and click on Delivery folder. 
List of documents prepared for sending is displayed on the screen. 

2. Select documents you wish to send to the bank and click on 
Delivery button. 

It opens a window in which you have to enter personal number (PIN) of 
a smart card: 



107 

 

Figure 80: Window in which you have to enter personal number (PIN) 

3. Plug in smart card, enter personal number (PIN) and click on OK 
button. 

Program starts connection with a bank (Figure 81). 

 

Figure 81: Connection and exchange of documents 

When connection is established chosen documents are transferred on 
bank server. Depending on settings, bank documents and newest data 
are transferred on your computer. After successfully documents 
exchange, connection with a bank ends and detail window with sent and 
received documents information displays: 
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Figure 82: Details about sent and received documents 

4. Close window with Close button. 

While exchanging documents, if there is a new version of Hal E-Bank 
program, you will receive notice. 

If connection couldn’t be established, documents will not be transferred. 
In that case notice will be displayed on the screen. 

Successfully sent documents disappear from Delivery folder, and at the 
same time, move from Preparation folder to Archive folder. 

13.2.1 Handling of "grey" orders in a Delivery folder 

In a case that there are some difficulties in a communication with a 
server or reading a smart card while sending documents, it could occur 
that after sending, documents stay in Delivery folder in a grey color, 
and disappear from Preparation folder and Archive folder. That 
means that documents were sent to the bank, but there are no 
confirmation about it because an error in communication.  

Program Hal E-Bank alerts you about "grey" orders existence: 

• By starting, program checks all accounts for all banks you work 
with. If there is "grey" orders, it displays warning with data for 
which accounts this orders exist, and manual with information 
what can you do with them.  

• When you refresh data from bank server, program checks 
existence of "grey" orders on bank accounts that you are 
connected with. If there are "grey" orders, you receive warning. 

• If you open Delivery folder and there are "grey" orders, Hal E-
Bank warns you.   
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What can you do with "grey" orders? 

• You can leave them as they are, but the program will warn you 
about them every time. 

• You can send "grey" orders, again. Choose them and send them 
as other documents. 

• You can delete "grey" orders from Delivery folder. It would send 
them into Archive folder with "no confirmation" status. 

Handled orders, which are in the Archive folder with "no 
confirmation" status, status will be changed when appropriate 
transaction receives. 

If error occurs while sending documents, and you are not sure if 
you sent them correctly, call bank employee for your account. He 
will check which document bank received. 

13.3 Downloading documents from the bank 
Restoration of data is intended for downloading from bank server: 

account status, transactions, statements, bank information, code files, 
new authorizations, files etc. It restores data for all accounts opened in a 
bank with which you are connected. 

1. In a toolbar, click on the first icon from the left (Restore content over the 
net) or in a main menu choose option Communication/Connection with 
bank server. 

 

It opens a window in which you have to enter personal number (PIN) of 
a smart card: 

 

2. Plug in smart card, enter personal number (PIN) and click on OK button. 
Program starts connection with a bank (Figure 83). 
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Figure 83: Connection and exchange of documents 

When connection is established all handled documents and newest 
status information on all bank accounts with which you are connected. 
After successfully documents exchange, connection with a bank ends and 
detail window with received documents information displays (Figure 84). 
All received documents are in respondent folders. 

 

Figure 84: Detail window about received documents 

3. You can close window by clicking Close button.  

While exchanging documents, if there is a new version of Hal E-Bank 
program, you will receive notice. 

If connection couldn’t be established, documents will not be transferred. 
In that case notice will be displayed on the screen. 

While exchange documents, if bank send you important information you 
will be warned (Figure 85): 
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Figure 85: Warning about important information 

4. Click on OK button. 

It displays review of important information window (Figure 86). 

 

Figure 86: Review of important information window 

5. In a case that you wish to review important information, select it and click 
on Open button. 

6. You can close window on Close button. 

13.4 Upgrading Hal E-Bank program 
When you want to upgrade existing version of Hal E-Bank program with 

a new one you use program upgrade. Code files could be upgraded 
independently, while refreshing contents. While upgrading program Hal 
E-Bank have to be closed. While upgrading network version of Hal E-Bank 
program, it’s needed to be upgraded on each computer (client). 

You can upgrade it by following next steps: 

1. Click on Tools in main menu and choose option Program updating or in a 
toolbar click on refreshing icon. 

 

 
2. On a Question (Figure 87) click Yes. 
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Figure 87: Updating program 

Program Hal E-Bank closes; on the screen is displayed upgrading 
dialog. Leave parameters unmodified. 

3. If you want to upgrade program click on Upgrade button. 

Click on Cancel button if you don’t want to upgrade program. 

Program will establish connection with a bank server and download 
latest version code files and Hal E-Bank program. If the latest version of 
program is already installed on your computer, program will not 
download it from the bank server. Duration of downloading depends on 
your computer speed, modem, quality of connection, file size. 

13.4.1 Sending orders in signing 

If you wish to send one or more orders in signing, follow the 
instructions: 

1. Open the Order preparation folder by clicking Preparation in the 
left part of the window and then orders or batches (if you do 
business with batches) under it. 

A list of payment orders will appear on the screen (it can be blank). 

2. Select orders you wish to send in signing. You can send in 
sending only the orders which do not include errors and carry the 
ready status.  Selected orders are made out inversely.  

3. Click Other with the left mouse button and select Send in 
signing from the list.   

A window for entering Smartcard number (PIN code) appears: 
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4. Insert your Smartcard, enter your personal number and click OK 
to confirm. 

The program will begin to establish a connection with the bank 
(Figure 88) 

 

Figure 88: Establishing a connection and sending orders in signing 

When the connection has been successfully established, selected 
orders are transferred to the bank’s computer. After the orders have 
been transferred, the connection is automatically cut off and a window 
appears including data about sent orders: 

 

Figure 89:  Sent orders details 

5. Close the window by clicking Close. 
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Successfully sent orders are in the Preparation orders or in 
batches folder (if you do business with batches) obtaining the status 
"in remote signing".  

You can finally sing an order via the Internet by means of a web 
application Hal E-Bank/Web. When an order has been sent into 
signing, you cannot sign it finally from the Hal E-Bank, but you can 
return it to Hal E-Bank from Hal E-Bank/Web. 

13.4.2 Signing batches in Hal E-Bank/Web 

A batch of payment orders that have been successfully sent to 
remote signing can be seen in web application Hal E-Bank/Web in the 
Signing window as presented on the figure below.  

 

Figure 90: Signing the batches in Hal E-Bank/Web 

The window enables you to review the batches waiting for final 
signature.   If you operate with more than one account and wish to 
check the batches on all your accounts, click Show all accounts on 
the right side of the Account field. 

Unsigned batches are copied out in tabular form including the 
following data: 

• creation date, 

• document type, 

• number of orders, 

• checksum, 

• status, and 

• account.  
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If there is more than one page of items, there appear links on the top 
of the chart guiding you to the previous, the next, and each separate 
page. At the bottom of the table a total of amounts of this page 
appears.   

If you wish to sign the batch, click the  Sign icon in the far right 
column. 

The Batch data window enables you to print the batch data. You can 
also finally sign the batch here, if it has not been signed yet. There 
appear batch data in the upper part of the window: 

• reference, 

• batch ID, 

• debit account number, 

• order type in batch, 

• number of orders in batch, 

• checksum, 

• prepared by, 

• batch creation date, 

• batch status,  

• status change time, and 

• sender’s name and surname. 

 

 

Figure 91: Batch data in Hal E-Bank/Web 

In the continuation existent batch signers are displayed. On the left 
hand side there are left-side signers, and on the right there are right 
batch signers. Signer category is indicated in square brackets next to 
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the name of the signer. If signature is not required, signer spot is 
marked by an »X« sign, but if there is no signature yet, there appears 
a »?«. 

In case a batch has not been finally signed yet, it can be either 
signed or returned back to the preparation. By clicking Sign a batch is 
signed according to signer category.  

If you wish to see the orders belonging to a batch, click Orders in 
the batch in the lower part. By clicking Back you go back to the page 
containing a list of orders. 

By clicking Return to preparation, a batch is returned for 
preparation to the client who sent it into signing. When returning a 
batch, it is necessary to give a reason why it has been returned into 
the Comment on Batch Returning (Figure 78) window. Click OK to 
confirm the comment. 

 

Figure 92: Comment on Batch Returning 

A returned batch includes only the signatures it had included before it 
was sent to signing. When you receive data, you also get a notice in 
the client about the returned batch, as indicated below (Figure 79). 

 

Figure 93: Returned document  
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13.4.3 Signing batches in Hal E-Bank/Web 

Payment orders that have been successfully sent to remote signing 
can be seen in web application Hal E-Bank/Web in the Signing window 
as presented on the figure below.  

 

 

Figure 94: Orders signing 

The window enables you to select orders for signature and delivery 
into bank processing. 

If you operate with more than one account and wish to check the 
batches on all your accounts, click Show all accounts on the right 
side of the Account field. 

The window shows orders sent in signing. Orders are copied out in 
tabular form and include the following data: 

• value date, 

• beneficiary, 

• amount, 

• currency, and  

• details.  

By clicking an order in the last column, you select the order you wish 
to confirm. When the order is selected, the amount in the Amount of 
selected orders field below increases in accordance with the selected 
order. By another click on the order, the latter is excluded from the list 
of orders waiting to be signed. 
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 By clicking Select all you can select all the displayed orders for 
confirmation. 

By clicking Sign, orders are confirmed and finally sent to processing.   
If you wish to send the orders back to preparation, click the Back to 
preparation button.  When you receive data you also get a notice in 
the client about the returned order. 
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14 Transactions, balances and statements 

14.1 Transactions on account 
A bank generates and sends transaction statements for all changes on 

your accounts. These items can be: credits, debits, rejected orders, 
reversed credits, reversed debits, revoked orders. 

14.1.1 Reviewing transactions 

To review transactions click on Review folder and then on 
Transaction. A list of transaction items is displayed for the selected 
account and time period. 

 

Figure 95: Transactions 

The meaning of colours of transaction items: 

Colour State 
Red Outflow with received statement 
Purple Current daily transactions (all types) 
Grey Rejected, revoked, and reversed order 
Blue Inflow with received statement 
Orange Bank commission 
Black Revoked 

To see more information about a certain transaction, mark the line 
containing that action and click Open or simply double-click it. A window 
opens with details of the selected transaction. 

14.1.2 Export transactions 

You can export transactions into ordinary text files for further 



120 

processing with other programs. 

 Details about exporting transactions are explained in the section 
Connection with other programs. 

14.2 Balances on accounts 
To review balances on your accounts open the Review/Balance folder. 

The list of balances and transactions on accounts displays on the screen. 

 

 

Figure 96: Review balances and transaction on account 

Details about transactions on the account can be reviewed by clicking 
Transactions at the bottom of the window. 

A new window opens with transaction details on the selected account. 

Transaction data are separated between three tabs. 

Details about the individual item are displayed by clicking Open. 

To return to Review/Balance folder click Inter. Balance at the 
bottom. 
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Figure 97: Transaction details on the account 

14.2.1 Reviewing balance on account 

If you use Hal E-bank for more than one account you can set the 
default account balance view, which is active when you reviewing 
balance on account. 

To set the default account balance view, use the following procedure. 

1. Click on the Settings icon in the toolbar, or select Tools, 
Settings option from main menu. 

 

2. Select the Review balance. 

3. With the left mouse button click Add.  

A dialog box Add/Change into account balance view is displayed. 

4. Enter a name for view into a Descriptive name of field. 

5. In the List of your accounts select account, witch you wont 
to be displayed in to Review balance and move them whit 
button Add > or Add all>>. 

If you wont to remove account from list Selected accounts, than use 
the button Remove> or Remove all >>. Confirm your settings by 
clicking OK or click Cancel to discard entered data. 
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Figure 98: Add/Change into accounts balance view 

When you confirm the settings a dialog window Review balance is 
displayed. 

 

Figure 99: Settings/Review balance 

You can also define witch default account balance view is displayed 
when you open a folder Reviewing/Balance. From drop-down menu 
select balance view and click in the check box Default account 
balance view. 

14.3 Statements 
Bank statements sent for each account separately are listed in the 

Review/Statements folder. By choosing this option, the list of 
statements opens for selected account and time date. 
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Figure 100: Statements 

The statements which you already review are marked whit symbol . 

You can export transactions into ordinary text files for further 
processing with other programs. 

Details about exporting statements are explained in the section 
Connection with other programs. 
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15 Previewing and printing documents 

You can preview and print most documents in Hal E-bank: orders, 
batches, messages, transactions, statements, and notices. For this 
operations use Preview and Print buttons in the corresponding folders. 

15.1 Previewing documents 
In folders that support previewing of documents select the document 

you wish to preview and click Preview (Preview button is in the line 
with function buttons at the bottom of application. Alternatively: right-
click the document and select the operation from the menu). If no 
document is selected, the Preview button is inactive (greyed out). A 
document is displayed on screen as if printed on paper. 

To print the documents click the  icon in the upper-left corner of the 

window. Beside it there is the  icon for exporting the document to a 
file. Close the window by clicking the  button in the upper-right corner. 

15.2 Printing documents 
In folders that support printing of documents select the document you 

wish to print and click Print (Print button is in the line with function 
buttons at the bottom of application). If no document is selected, the 
Preview button is inactive (greyed out). Printing can be performed in 
several ways: 

• By clicking on the functional button Print, or 

• By clicking the printer icon on the toolbar, or 

• By choosing option Data/Print from main menu.  

 

Select one of these options. A system window opens for printer 
settings. Confirm your setting by clicking Print. 
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16 Infrequent activities 

16.1 Maintaining the Address book of 
beneficiaries and their accounts 

For storing and maintaining information about legal and private entities 
– beneficiaries of payments and their accounts - an address book was 
added to Hal E-Bank. With the single-user version – Hal E-Bank/Personal 
- the address book is stored on a local computer, while with the multi-
user version – Hal E-Bank/Corporate - it is stored on the database server.  

After installing Hal E-Bank, Address book contains data about banks and 
their accounts. 

You can access the Address book of beneficiaries and their accounts in 
two ways: 

• While filling payment orders (transaction orders, compensation) 
when you select the beneficiary of payment, or by 

• Using the toolbar or Address Book option from the Tools menu. 

 

In the first case function of Address Book is to select beneficiary. Use 
the button Select to transfer data about beneficiary and his account on 
the payment order. In the second case button Select is not available. In 
both cases you can add or edit data in the Address Book. 

For fast search enter the first few characters of the name into the 
Beneficiary's name field.  

Displayed list can be ordered alphabetically by clicking on the header of 
the Name or City column. If the list is too long use the scroll bar on the 
right side of the list to find beneficiary you want. 

To search for beneficiary's name for which you know only a group of 
letters which are not at the beginning of his name, enter the sign % in 
front of that group. For example, %d.o.o. will display all names which 
contain the d.o.o string. 

In the lower part of the window - Beneficiary accounts - the list of 
accounts of the selected beneficiary is shown. If there is no information 
about the accounts of the selected beneficiary's the list remains empty. If 
the beneficiary has only one account that account is selected 
automatically – it is highlighted. If the list contains several accounts 
select the one you want. If the list of accounts is too long use the scroll 
bar on the right side of the list to find account you want. 

Information about the bank which holds the selected account is shown 
on the left side of the list of accounts (Figure 101). 
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Figure 101: The Address book of beneficiaries and their accounts 

16.1.1 Adding beneficiary in the Address book of 
beneficiaries and their accounts 

 To add a new beneficiary to the address book, use the following 
procedure: 

1. Select the Address book from the Tools menu or click the 
Address book icon on the toolbar. 

2. Click Add address>> at the right of the displayed list of 
beneficiaries. 

A dialog window opens which enables data entry for the new beneficiary 
(Figure 101). 

3. In the Name field enter company or person name.  

The contents of the Name field is used for searching through the 
address book, so be careful when entering information. If you enter 
wrong data, you may experience problems when searching for the entry. 

Press the <Tab> key to move on the next field or just click on it.  

4. In the Address field enter the address and press the <Tab> 
key or click on the next field.  

5. In the City field enter the post code and the city and press the 
<Tab> key or click on the next field.  

6. From the dropdown list Country select country and press 
<Tab> key or click on the next field. 
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7. Optional notes, up to 140 characters, can be added in the field 
Remark.  

The order by which you enter the information is not predetermined. To 
move between the fields use key <Tab>, <Shift>+<Tab> or mouse 
click. 

8. Click on the button OK to save new beneficiary in the Address 
book, or click on the Cancel button to cancel adding.  

 

Figure 102: Adding beneficiary's data 

16.1.2 Adding account number in the Address book of 
beneficiaries and their accounts 

Account numbers have to be entered in the format accounts at 
domestic banks). Several beneficiaries accounts opened at different 
banks can be entered to the address book. New account data can be 
entered by following this procedure: 

1. Select the Address book from the Tools menu or click the 
Address book icon on the toolbar. 

2. From the upper list select the beneficiary for whom you want to 
add a new account. To find beneficiary use Beneficiary name 
field to enter a few first letters of the name, or use scroll bar on 
the right side of the list. 

All accounts of selected beneficiary that are already entered in the 
Address book are shown in the lower list.  If there is no information 
about the accounts of the selected beneficiary's the list remains empty. 
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3. Click on the Add an account>> button, above the list of 
accounts. A dialog window is displayed which enables data entry 
for the new beneficiary's account (Figure 103). 

4. Enter the account number in the Account field in proper format. 
The formats of foreign accounts are not controlled. 

If the address book recognizes the account number, information on 
the correspondent bank is displayed in the corner below. If Select a 
bank button is enabled bank can be selected manually.  

When entering a foreign account you can select the bank which holds 
the beneficiary's account by clicking Select a bank >>. 

A dialog window is displayed (Figure 104) which enables you to select 
the corresponding bank from the list. If the bank is not on the list, the 
information about the bank can be entered by clicking Add>> button 
(Figure 104). 

5. Select the bank where the beneficiary is holding the account 
that you wish to add. When searching for the bank, use the 
Bank name field to enter a few first letters of the name, or use 
scroll bar on the right side of the list. 

Selected bank have to be highlighted. 

6. Click on the Select button. 

The information about the selected bank will be shown in the window 
for entering the account of the beneficiary. 

7. Click OK to save the information to the address book or click 
Cancel to discard entered data. 
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Figure 103: Adding a new account 

 

Figure 104: The dialog window for bank selection 



130 

16.1.3 Editing beneficiary's general data 

 The information in the Address Book of beneficiaries and their 
accounts can be edited using the following procedure: 

1. Select the Address book from the Tools menu or click the 
Address book icon on the toolbar. 

2. Select the beneficiary whose information you want to edit in the 
list of beneficiaries. When looking for the wanted name, use the 
Beneficiary's name field to enter the first few characters of 
the name or surname to be searched for, or use the scroll bar 
on the right side of the list (Figure 101). 

3. Selected beneficiary have to be highlighted. 

4. Click on the Correct the address >> button to edit the 
beneficiary's general data. 

A dialog window is displayed, which allows editing beneficiary's data. 
The window contains the same fields as the window for entering a new 
beneficiary. For detailed information about entering data in fields read 
a section 16.1.1 Adding beneficiary in the Address book of beneficiaries 
and their accounts. 

5. Edit beneficiary's general data. To move between the fields use 
key <Tab>, <Shift>+<Tab> or mouse click. 

6. Click on the OK button to save edited data or click on the 
Cancel button to discard changes. 

16.1.4 Editing beneficiary's account data 

To edit beneficiary's account data use the following procedure: 

1. Select the Address book from the Tools menu or click the 
Address book icon on the toolbar. 

2. Select the beneficiary whose information you want to edit in the 
list of beneficiaries. When looking for the wanted name, use the 
Beneficiary's name field to enter the first few characters of 
the name or surname to be searched for, or use the scroll bar 
on the right side of the list (Figure 101). 

Selected beneficiary have to be highlighted. 

All accounts of selected beneficiary that are already entered in the 
Address book are shown in the lower list. 

3. If the list of accounts holds two or more accounts, select the 
one you wish to change. 

Selected account has to be highlighted. 

4. Click on the Correct the account>> button above the list of 
accounts. 

A dialog window is displayed which allows editing beneficiary’s 
account (Figure 103). The window contains the same fields as the 
window for entering a new beneficiary's account. For detailed 
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information about entering data in fields read a section Error! 
Reference source not found. Error! Reference source not found.. 

5. Edit beneficiary's account data. 

6. Click on the OK button to save edited data or click on the 
Cancel button to discard changes. 

16.1.5 Deleting beneficiary from the Address book 

 To delete the information about beneficiary, together with the 
information about his accounts from the Address Book, use the 
following procedure: 

1. Select the Address book from the Tools menu or click the 
Address book icon on the toolbar. 

2. Select the beneficiary whose information you want to delete in 
the list of beneficiaries. When looking for the wanted name, use 
the Beneficiary's name field to enter the first few characters 
of the name or surname to be searched for, or use the scroll bar 
on the right side of the list. 

Selected beneficiary have to be highlighted. 

3. Click on the Delete button, on the right side of the list. 

A message of confirmation is displayed with the information about 
selected beneficiary and his accounts. 

4. Confirm the deletion by clicking Yes or cancel it by clicking No. 

When you delete the beneficiary from the address book, you can no 
longer retrieve it. The information about his accounts is also erased. 
Caution is advised. Later, if you want to use deleted beneficiary again, 
you have to enter all information about him and his accounts. 

16.1.6 Deleting beneficiary's account 

 To delete the information about beneficiary's account from the 
Address Book, use the following procedure: 

1. Select the Address book from the Tools menu or click the 
Address book icon on the toolbar. 

2. Select the beneficiary whose information you want to delete in 
the list of beneficiaries. When looking for the wanted name, use 
the Beneficiary's name field to enter the first few characters 
of the name or surname to be searched for, or use the scroll bar 
on the right side of the list. 

Selected beneficiary have to be highlighted. 

All accounts of selected beneficiary that are already entered in the 
Address book are shown in the lower list. 

3. If the list of accounts holds two or more accounts, select the 
one you wish to delete. 

4. Click on the Delete button above the list of accounts. 
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A message of confirmation is displayed with the information about 
the selected account. 

5. Confirm the deletion by clicking Yes or cancel it by clicking No. 

When you delete the beneficiary from the address book, you can no 
longer retrieve it. Later, if you want to use deleted account, you have 
to enter all needed information again. 

16.1.7 Converting accounts from BBAN to IBAN form 

All the users are given the opportunity to convert their existing 
accounts to IBAN form. For this purpose Hal E-bank 
Personal/Corporate has drawn up a program for converting accounts to 
IBAN form. 

 

Instructions for use for AccountConverter.exe program: 

 
1. Go to the folder where Hal E-bank Personal/Corporate program 

is installed and run  AccountConverter.exe program: 

 

 

 
 

Figure 105: Window of a folder with AccountConverter.exe program 

2. A window with a description of the program appears: 
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Figure 106: Window with the program description 

 
3. After clicking »Next« a window appears including a list of all the 

accounts existing in the local address book in BBAN form. Here 
we can define which accounts you would like to convert to IBAN 
form. Click »Remaining Accounts« and a list of all accounts in 
IBAN form will appear. 

 

 
Figure 107: Window with a list of all the accounts existing in the local 

address book in BBAN form 

4. Click »Next« and a window will appear informing you about a 
successful conversion of selected accounts to IBAN form. In case 
of difficulties with account conversion, the program reports an 
error with a description and a cause for it. 
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Figure 108: Window with a message about the conversion of the 
selected accounts to IBAN form 

 

16.1.8 The Address Book of banks 

Address book provides adding new banks, and deleting or editing 
data for manually added banks. 

You can access the Address Book of Banks in two ways: 

1. While adding or editing beneficiary's account by clicking on the 
Select a bank >> button, in the way described in a section 
Error! Reference source not found. or 

2. by clicking Address book of banks button in the lower left side 
in the Address Book of beneficiary's and their accounts (Figure 
109). 

In the first case button Select>> is available, which links data about 
selected bank with beneficiary's account. In the second case you can 
back to the Address Book of beneficiaries and their accounts by 
clicking Beneficiaries and their accounts button. 
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Figure 109: The Address Book of Banks 

Banks marked with letter R in the Source column cannot be deleted 
or edited. 

16.1.8.1 Adding a bank to the address book 

To add a new bank to the address book use the following 
procedure: 

1. In the address book of banks click Add>>. 

A dialog window for entering the information about the bank is 
displayed (Figure 110). 

2. In the Name field enter bank name, and press key <Tab> or 
click on the next field. 

The contents of the Name field is used for searching through the 
address book, so be careful when entering information. If you enter 
wrong data, you may experience problems when searching for the 
entry. 

3. In the Address field enter the address and press the <Tab> 
key or click on the next field. 

4. In the City field enter the post code and the city and press the 
<Tab> key or click on the next field. 

5. From the dropdown list Country select country and press 
<Tab> key or click on the next field. 

6. In the SWIFT BIC field enter international bank identifier *up 
to 11 characters) and press the <Tab> key or click on the 
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next field. 

7. In the Bank identifier enter bank's account and press the 
<Tab> key or click on the next field. 

8. Optional notes, up to 140 characters, can be added in the field 
Remark. 

9. To add bank as beneficiary check the check box Add the bank 
as the beneficiary as well. Banks marked with the letter R in 
the column Source are already beneficiaries. 

 
Figure 110: Adding a bank to the address book 

The order by which you enter the information is not 
predetermined. To move between the fields use key <Tab>, 
<Shift>+<Tab> or mouse click. 

Click on the button OK to save new beneficiary in the Address 
book, or click on the Cancel button to cancel adding. 

Added bank is marked with the letter U in the column Source. 

16.1.8.2 Editing added bank data 

To edit data of added bank in the address book of banks use the 
following procedure: 

1. Select the bank from the list of banks. To find the bank you 
want, use the field Bank name to enter the first few 
characters of the name to be searched for, or use the scroll 
bar on the right side of the list. You can edit only a data of 
the added banks. These banks are marked with the letter U in 
the Source column. 
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2. Click the Edit>> button. 

A dialog window is displayed, which allows bank's data. Only 
difference between this window and window for entering a new bank 
is in disabled check box Add the bank as the beneficiary as well 
(Figure 110). 

3. Edit bank's data and click the OK button to save edited data 
or click the Cancel button to discard changes. 

16.1.8.3 Deleting added bank from address book 

To delete added bank from the address book of banks, use the 
following procedure: 

1. Select the bank from the list of banks. To find the bank you 
want, use the field Bank name to enter the first few characters 
of the name to be searched for, or use the scroll bar on the 
right side of the list (Error! Reference source not found.). 
You can edit only a data of the added banks. These banks are 
marked with the letter U in the Source column. 

2. Click the Delete button. 

3. Confirm the deletion of the selected bank by clicking Yes, or 
cancel it by clicking No. 

When you delete the information about a bank from the address 
book, you can no longer retrieve it. If you would like to use the 
information about the deleted bank later on, you would have to 
enter all the information about the bank anew. 

This procedure only deletes a bank from the address book of banks 
- you can still use it as a beneficiary. 

16.2 Changing personal identification number 
(PIN)  

From security or any other reasons you can change your personal 
identification number (PIN). When entering new PIN be careful, especially 
when using small and capital letters, or Y and Z keys (their position 
might be changed on the keyboard). 

To change PIN, use the following procedure: 

1. Select PIN Change from the Tools menu or click Change PIN icon 
on the toolbar. 

 

2. To continue click Yes, or click No to cancel PIN changing. 

Hal E-Bank program closes and a dialog window for changing the 
personal number is displayed on the screen. Enter correctly all personal 
numbers required: the old one and the new one, twice. 

3. To confirm change click the OK button, or click the Cancel button to 
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discard change. 

 

Figure 111: Change of PIN 

The program will change the personal identification number of your 
smart card (PIN). The new personal identification number (PIN) will now 
be used in the Hal E-Bank program. 

16.3 Deleting old data (database cleanup) 
 With this option you can quickly and simply erase all old and unneeded 

information. The information is erased depending on time passed, and is 
done by entering the date. 

If you want to erase all the transaction items, payment orders, 
messages and notices, that are older that the certain date, use the 
following procedure: 

1. Select Database cleanup from the Tools menu or click the Delete 
old data icon on the toolbar. 

 

2. To continue, confirm control question by clicking the Yes button. 
Otherwise click the No button to back into to the Hal E-bank. 

If you clicked Yes button, Hal E-Bank program will close and a dialog 
window will be shown on the screen (Figure 112). 

 

Figure 112: Cleaning database 

3. Enter the date until which you request the data to be deleted in the 
Clean from: field. 

4. Click the Clean database button to clean up the database of old 
data. 

Confirm deleting by clicking Yes, or cancel operation by clicking the No 
button.  

The program will delete all data older than the specified date. 
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16.4 Limitation of number of displayed 
documents 

When you have a large number of documents program provides 
limitation of number of displayed documents. 

1. Click on the Settings icon in the toolbar, or select Tools, 
Settings option from main menu. 

 

2. Select Diverse tab. 

3. In the field Maximum number of displayed document enter 
number of documents you want to b displayed. 

In case that in some of folders exist number of documents larger then 
defined number for limitation, message will be shown. 

 

16.5 Setting default account and maximum 
number of displayed documents 

If you use Hal E-bank for more than one account you can set the 
default account which is active when you start the program. 

To set the default account, use the following procedure. 

1. Click on the Settings icon in the toolbar, or select Tools, Settings 
option from main menu. 

 

2. Select the Diverse tab. 

3. Select the default account number from the drop-down list in the 
Default account while starting the program field. 

You can also define the default deal type which is displayed when you 
open a new payment order). 

4. In the Maximum number of displayed documents field insert 
the number of documents you wish to be displayed. 
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Figure 113: Diverse 

16.6 Creating shortcuts for Payment details 
entry 

When you are preparing payment orders for domestic payment system, 
you can easily enter the data into the Payment details by preparing 12 
different details beforehand and then activating them to fill out Payment 
details by using function keys F 1 to F 12. 

Shortcuts are saved even after you leave the Hal E-Bank program. If 
you are using the networking version of Hal E-Bank program, you have to 
create shortcuts on every user computer (client) separately. 

We advise you to create shortcuts for Payment details you use 
frequently. Shortcut text can be modified at any time.  

You can create shortcuts for Payment details entry according to the 
following instructions: 
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1. Click the Settings button in the toolbox or select Settings from 
the Tools menu command.  

2. Select the Payment details tab. 

3. Enter the text into the field next to the function key sign. 

4. Click OK to confirm the settings changes or cancel them by clicking 
Cancel.  In the latter case, settings confirmed last will remain 
valid. 

Data in the Payment details field can be either supplemented or 
corrected. 

16.7 Reviewing the balance 
If you wish different reviews of your balance, follow the instructions: 

1. Click the Settings button in the toolbox or select Settings from 
the Tools menu command.  

 

2. Select the Review balance tab. 
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Figure 114: Accounts balances reviews 

A window enabling you to arrange various reviews appears. If you wish 
to add a review of new accounts balances or just modify the existing one, 
click Add or Change. A window Add/Change accounts balances 
review (Figure 86) appears.  

If desired, you can name or modify the review in the Descriptive 
name of review field. From the account list select or remove accounts 
you wish/don’t wish to check the balance of. Add accounts by using 
Add> and Add all>>, or remove them by using <Remove and 
<<Remove all. 

Confirm your entry or modification by clicking OK or cancel it by clicking 
Cancel. 
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Figure 115: Add/Change accounts balances review  

16.8 Creating descriptive names for my accounts 
If you think your work with accounts would be easier if you had a 

descriptive name for your account instead of an account number, do the 
following: 

1. Click the Settings button in the toolbox or select Settings from 
the Tools menu command.  

 

2. Select the My accounts and descriptive names tab. 
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Figure 116: Reviews into account balances 

A sub-window in which you can create your account description 
appears. With a mouse select an account you wish to add a descriptive 
name to and click Add. A window Add a descriptive account name 
(Figure 73) appears. 

 

Figure 117: Add a descriptive account name  

Enter a desired name into the Descriptive account name field. Click 
OK to confirm your choice or Cancel to cancel it.   
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You can also modify descriptive names of your accounts. From the 
account list select the account for which you wish to modify the name 
and click Change. A window Change descriptive account name will 
appear where you can modify the name of your account. Click OK to 
confirm the modification or Cancel to cancel it.  Click Delete to delete a 
descriptive name. 

Tick Show my accounts with descriptive names so that descriptive 
names will appear in the client. 

 

16.9 Setting default account and default deal 
type 

If you have more accounts with one or various banks, the program 
enables you to set an account you wish to show up when you start the 
program. 

Follow the procedure described below to set a default account. 

5. Click the Settings button in the toolbox or select Settings from 
the Tools menu command.  

 

6. Select the Other tab. 

7. Select an account from the combo box in the Default active 
account number shown upon program booting field. 

You can also set a default deal type showing up when you open a new 
payment order (BN01 and special payment slip). 

Follow the procedure described below to set a default deal type. 

1. Click the Settings button in the toolbox or select Settings from 
the Tools menu command.  

 

2. Select the Other tab. 

3. Enter a suitable deal type by selecting from the combo box into the 
Default deal type for a payment order field. 

16.10 Amount limit on special payment slip 
You can limit the amount on special payment slip. 

The amount limit can be set according to the procedure described 
below. 

1. Click the Settings button in the toolbox or select Settings from 
the Tools menu command.  
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2. Select the Other tab. 

3. Enter the desired amount into the Amount limit on special 
payment slip field. 

If you do not enter the desired amount, the program will not check it 
up. If you have entered the desired amount, you will be alerted when the 
amount is exceeded. 

 

16.11 Setting import and export converters  
There are two ways of how orders in domestic payment system can be 

imported in accordance with the structure of the file. Orders from Hal E-
Bank are exported in the format described in appendix. 

Orders can also be prepared according to the Instructions on 
submission and receipt of data from payment instructions and statement 
on transactions and balance in computer form (Navodila za predložitev in 
prevzem podatkov s plačilnih navodil in izpiska o prometu in stanju v 
računalniški obliki) published in the Official Gazette number 56/2002.  

If you wish to consider cover and header records when importing, set it 
following the instructions below. 

1. Click the Settings button in the toolbox or select Settings from 
the Tools menu command.  

 

2. Select the Import/Export tab. 

3. Select a payment system type in the Payment system frame. 

4. Enter a document type (for example DPS transactions, FPS 
orders,…) into the Document type field. 

5. In the Default converters for selected document type frame 
select a converter of import and export from the list of converters.   

6. Click the OK button to confirm your selection.   
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Figure 118: Import/Export 

16.12 Setting default e-form* 
*The program also enables you to set a default e-form, which will 

appear at the start of the program, in the folder according to 
transactions.  

Follow the procedure described below to set a default active account 
number. 

1. Click the Settings button in the toolbox or select Settings from 
the Tools menu command.  

 

2. Select the E-forms tab. 
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Figure 119: Setting default e-form 

3. In the Bank field select a bank from the combo box. 

4. In the Payment system field select a payment system from the 
drop-down menu. 

5. From the Preparation, Archive, Review folders in the lower field, 
you can select a document type from the drop-down menu. 
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17 Exchanging data with other programs 

This chapter describes procedures that enable Hal E-Bank to establish a 
connection with other programs. This connection is established by using 
standardized text files for exchanging information. You have to make sure 
that the program with which you are exchanging the information can import 
and export these standardized files. Format of standardized files is based of 
defined format of the EBB, given in Appendix. 

17.1 Payment orders 
Payment orders include transaction payment orders and compensations. 

Payment orders can be prepared in other (accounting) program and then 
imported into the Hal E-Bank program, signed and sent to the bank to be 
processed. You can also export payment orders to text files from Hal E-
Bank.  

17.1.1 Import orders from text files 

Payment orders can be imported from another program to Hal E-
Bank program using standard text files, described in Appendix. 

To import payment orders use the following procedure: 

1. Select the Preparation/orders folder. 

2. Click (Im/Ex)port and select the Import option from the menu. 

A standard dialog box (Open) is displayed, which requires from you 
to select the name of the file to be imported. 

3. Search for the file you wish to import. Confirm the choice by 
clicking the <Enter> key, or click Open. 

If the wanted name of the file is not among the displayed ones, use 
the slider or look for the file in another folder. The procedure of 
selecting the path and the file is standard for the MS Windows. If 
dialog box looks different read the instruction manual for MS Windows.  

The program starts importing payment orders from the selected file.  

If there is no file selected, or if it is not in the proper format, an error 
message is displayed. Select a file in the proper format. 

After successful import a dialog window is displayed stating the 
number of successfully imported payment orders. 

4. Click the OK button. 

Review the imported documents in the list of payment orders. If you 
don’t see the imported documents in the list of prepared orders 
perhaps you have a filter turned on. Try to remove the filter. 

With every import of payment orders for domestic payments, Hal E-
Bank records information about beneficiaries and their accounts to the 
file beneficiaries.txt. This file may contain information about 
beneficiaries that you might not yet have in the address book of 



150 

beneficiaries and their accounts. If you want to have the information 
about the beneficiaries from the imported payments, you have to 
import the file beneficiaries.txt. With every import of orders, the 
file of recipients is being enlarged with new information, one line for 
each order imported, so we recommend that you occasionally delete it. 

17.1.2 Exporting orders to text files 

Exporting orders enables you save payment orders to a text file and 
reuse them later by importing them to Hal E-bank, or some other 
program. This way you can, for instance, save your regular monthly 
orders, which you can import when need be, as is explained in the 
previous section. 

Both prepared and archived payment orders can be exported to a 
text file. 

To export selected payment orders to a file, use the following 
procedure: 

1. Open either the Preparation or Archive folder, and click on the 
orders. 

List of payment orders will be shown. 

2. Select the payment orders you want to export.  

3. Click (Im/Ex)port and select Export from the menu. If you 
opened the Archive/orders folder, click Export. 

The Save as dialog box shows up for entering the name of the file, to 
which the payment orders will be saved.   

4. Enter file name and press <Enter> or click Save. If there is a 
need choose path where file will be saved and press <Enter> or 
click Save. 

Before export begin program check if file with the name entered 
exists. If exists message will be displayed.  

5. To replace the existing file click Yes. In that case all data from old 
file will be lost. If you don't want to replace existing file click No. 
The Save as dialog box will be shown again to enter new file 
name. Enter new file name and press <Enter> or click Save. 

If dialog box looks different read the instruction manual for MS 
Window. 

When export is complete a message is displayed with information 
about the number of exported payment orders.  

6. Click the OK button to finish export. 

17.2 The Address Book of beneficiaries 
Information about business partners can be entered using Address Book 

of beneficiaries, a little application integrated with Hal E-Bank. After 
program installation Address Book contains only information about 
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domestic banks. 

You can import previously prepared information to the Address Book of 
beneficiaries and their accounts from a text (ASCII) file. You can also 
export data from the address book to a text file. Format of export/import 
file is described in the Appendix.  

Each time when importing domestic payment orders Hal E-Bank creates 
a file in appropriate format Error! Reference source not found.. File 
name is prejemnici.txt, and contains data about beneficiaries and 
their accounts. If file with domestic payment orders was created by other 
application, Address book of beneficiaries and their accounts could not 
contains beneficiary data. To import that data in the Address Book, 
import file prijemnici.txt, as t is described in section Error! 
Reference source not found.. During every import of payment orders 
information about beneficiary from each order will be saved in the 
beneficiaries.txt. It is recommended to delete file 
beneficiaries.txt from time to time. 

17.2.1 Importing data from textual file 

1. Select Address book from the Tools menu or click the Address 
book icon on the toolbar. 

 

The window Address Book of beneficiaries and their accounts 
will be displayed. 

2. Click Data Import button. 

A dialog box for importing data into Address Book will be displayed. 
Cick the Open... button. A standard dialog box (Open) is displayed, 
which requires from you to select the name of the file to be imported. 
Select the file and click Open. The name of selected file will be shown 
in the File name field.  

3. To import data from selected file click Import>>, or click 
Cancel to cancel the operation. 

 

Figure 120: Importing data 
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Progress bar shows information about part of imported data from the 
file. After the import is finished a report is displayed. The number of all 
read and rejected lines is given at the end of report. Rejected lines are 
marked with two exclamation marks (!!). If the report is too long use 
scroll bar on the right side of report to read it. The report is saved in 
the file with the same name as file from data was imported, and with 
the extension .err. The lines already stored in the Address Book are 
rejected with explanation: "… account … already exists."  

4. Click the Close button to finish import. 
If the report contains at least one rejected line you will need to 

establish the reason for it. If there are only a few rejected lines we 
recommend interactive entry of records according to the procedure 
explained in Section Payment orders. Alternativelly, correct the 
information in the file, and repeat the import. In this case, all 
previously successfully imported lines will be rejected since they 
already are stored in the Address Book. 

If you start importing from the file with the same name and 
path, the report about the performed import will be saved over 
the previous report, because the files with the old and new 
reports have the same name. 

17.2.2 Exporting data from Address Book to a file 

Data about your business partners and their accounts can be 
exported from the Address book of beneficiaries and their accounts to 
a text (ASCII) file at any time. 

17.2.2.1 Exporting data to txt file 

Select Address book from the Tools menu or click the Address 
book icon on the toolbar. 

 

The window Address Book of beneficiaries and their accounts 
will be displayed. 

1. Click Data Export button. 



153 

 

Figure 121: Exporting data 

Save As dialog window is displayed (Error! Reference source 
not found.), which requires from you to enter the name of the file 
to which the data will be saved to. The default name of the file is 
Imenik.txt in the installation folder of the Hal E-Bank program. 

2.  You can define different file name in the File name field 
(define path where file will be saved using Save in field if 
necessary). Confirm export by pressing <Enter> or clicking 
Save. 

Before export begin program check if file with the name entered 
exists. If exists message will be displayed. 

3. To replace the existing file click Yes. In that case all data from 
old file will be lost. If you don't want to replace existing file 
click No. The Save as dialog box will be shown again to enter 
new file name. Enter new file name and press <Enter> or click 
Save. 

When export is complete a message is displayed with a result of 
export. 

4. Click the OK button to finish export. 

Details concerning the format and contents of the text file are 
explained in Appendix. 

17.3 Transactions and statements 
A sub-window for reviewing transactions shows all the executed 

transactions in defined period. Transaction amounts are indicated in three 
columns: In debit, In credit, and Amount rejected/other.  There are 
your payments indicated in the first column, and payments of others onto 
your account in the second. The former are displayed in red, the latter in 
blue. The third column shows cancelled and rejected orders (in grey) 
including a reason for rejection in column Details. 
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17.3.1 Export (transfer of transactions into text file) 

By exporting transactions data into a text file, you enable other 
(accounting) programs to read and add them to their own files. 
Transactions can be exported in two ways: either from the Transactions 
or the Statements folder. We recommend you to export transactions 
from the Statements folder, because you export all transactions 
belonging to a selected statement in one move.   Format of outgoing files 
is the same in both cases. 

You can export data from the Transactions folder for either a separate 
transaction or for more transactions together in the framework of a 
selected account and time period. 

If you wish to export (write) transactions records in text file, do the 
following: 

1. In the right top part of the display select the account (in case there 
are more) from which you would like to export data. 

2. Click Review transactions in the left sub-window. 

The screen displays transactions for the period which is stated in the 
interval for showing transaction statements.  

3. Select a desired transactions period. 

4. Mark a transaction record you wish to export. 

You mark a transaction record by clicking it. Marked record is indicated 
in bold. If you wish to mark only specific orders, use <Shift> and 
<Control> keys.   

5. Click the Export button. 

A Save As window will appear asking you to enter a file name into 
which the selected transaction records will be written.  Default file name 
is IzvozPromet1.txt. During later exports a name of the file will be 
suggested which you used last when exporting transactions. 

6. If the file name is correct, confirm it by pressing <Enter> or 
clicking Save.  If the contrary holds true, state the correct file 
name (if necessary, state the whole procedure and file name) and 
press <Enter> or click Save.  

Before the program begins to write into a file, check if the stated file 
already exists. 

If the file already exists, a dialog box appears on the screen informing 
you that the file already exists. The program asks you if you wish to 
replace it. 

7. If you do not need former data from the file, click Yes. In this case 
former data from the file will be replaced by the just selected 
transaction record.  If you need former data from the file, click No.  
The program will enable you the entry of a new file name. Enter a 
new file name and press <Enter> or click Save.  

If a dialog box differs from the one we have just described, consult 
instructions for MS Windows. 
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The program will write the selected transaction records into a given file. 
When the writing is finished, a dialog box will appear displaying the 
number of registered transaction records. 

8. Click the OK button. 

The export of transaction records for the selected period is now 
finished. 

If you wish to export transaction records for a different period, repeat 
steps from 3 on. 

You can export data from the Statements folder for all transactions 
belonging to a selected statement. If you wish to export (write) 
transactions records belonging to one statement in a text file, do the 
following: 

1. In the right top part of the screen select the account (in case there 
are more) from which you would like to export data. 

2. Click Review statements in the left sub-window. 

There appear statements for a selected period. 

3. Select a desired period for reviewing the statements. 

4. Select a statement from which you would like to export 
transactions. 

5. Click Export and follow the procedure described in exporting 
transactions from the Review of transactions folder. 

Statements will be exported into a given file ending in .txt.   In 
addition to the statements, a summary of the statements will also be 
exported into a file with the same name ending in extension .cov. 

17.4 Expanded and adapted export of statements 
The basic purpose of this tool is to help Hal E-bank users when exporting 

DPS statements.  Expanded export includes a parameter set which is 
defined by a user. The user also selects a data separating sign enabling 
generation of a file format for simple data export into any other application, 
spreadsheet, etc.  

17.4.1 Expanded export parameters selection 

Program users are given the opportunity to switch on/off particular data 
from the parameter set by adjusting export file set to personal needs. All 
temporary or final parameter settings are saved, so that it is not 
necessary to define export parameters each time you export data. 
Review into the basic data set or its modification is enabled by means of 
a dialog box, where the user is given the opportunity to select a 
separation sign among individual data. 

Click Export▲ in the Review statements folder. 
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1. Click Expanded export parameters to set the parameters. A 
dialog box Expanded export parameters with basic data set for 
export (Figure76) appears.  

 

Figure 122: Basic data set for export 

Basic export data set is selected optionally by ticking a small window in 
front of data description.  After you have selected the data, click Save or 
Cancel if you are not satisfied with the choice.  

17.4.2 Export into a file 

In the Review statement folder select statements you wish to export 
into a file.  You mark a statement by clicking it. Marked statement is 
presented inversely. If you wish to select more statements, use <Shift> 
and <Control> keys.   

Click Export▲ to export extended file and then select Extended file.  A 
Save As window will appear demanding the entry of a file name into 
which the selected data will be written.  A default file name when 
exporting a file is ExtExport.txt. If the file name is correct, confirm it 
by pressing <Enter> or clicking Save.  If the contrary holds true, state 
the correct file name (if necessary, state the whole procedure and file 
name) and press <Enter> or click Save.  

Before the program begins to write into a file, make sure if the stated 
file already exists. 

If the file already exists, a dialog box will appear on the screen 
informing you that the file already exists. The program asks you if you 
wish to replace it. 

If you do not need former data from the file, click Yes. In this case 
former data will be replaced by the just selected payment orders.  If you 
need former data from the file, click No.  The program will enable you 
the entry of a new file name. 
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Figure 123: Dialog box "Save as"  

The program will write the selected data into a given file. When it 
finishes writing them, a dialog box will appear stating the number of 
registered data into a file. 

 

Figure 124: Notice 

Click OK to finish data export. 
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18 Hal E-Bank: Domestic payments 

18.1 Import/export formats 

18.1.1 Payment orders - export  

Files of exported payment orders (chapter 1.2 Settings of domestic 
payment of payment orders) are composed of rows with header 
sentence, row with summary sentence and one or more rows with 
individual sentences containing payment orders data. 

 

Legend; N - numeric, C – alphanumeric, D – date 

 

The line of header sentence has the format as follows: 

Position Length Type Contents 
1 18 N Ordering party account 

number 
1 5  Bank code and organization unit 

E.g.: 02241 
 

6 10  Ordering party account number 
E.g. 0015771808 

 
16 3  Empty (Spaces) 

19 35 C Ordering party name 
54 10 C Ordering party city 

 
Account 
number, name 
and location are 
copied from first 
order in the file. 
TRR example: 
02241-
0015771808 

64 6 D Valuation date – only if valuation date is the same 
for all orders  (DDMMYY) 

70 98  Empty (Spaces) 
168 12 C Spaces or string “MULTI E–BANK”* 
180 1 N Sentence type  (0 – main sentence) 
181 2 C Line brake (0x0D, 0x0A) 

 

The line of summary sentence has the format as follows: 

Position Length Type Contents 
1 18 N Ordering party account 

number  
1 5  Bank code and organization unit 

 
6 10  Ordering party account number 

 
16 3  Space 

19 35 C Ordering party name 
54 10 C Ordering party city 

 
Account 
number, name 
and location are 
copied from first 
order in the file. 

64 15 N Total amount of all orders (last 2 digits are 
decimal places without coma) 

79 5 N Number of debit orders 
84 96  Empty (Spaces) 
180 1 N Sentence type  (9 –summary sentence) 
181 2 C Line brake (0x0D, 0x0A) 

 

The line of individual sentence has next format: 
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Position Length Type Contents 
1 18 N Beneficiary account  

1 5  Beneficiary bank code and organization unit 
 

6 10  Beneficiary account number 
 

16 3  Empty (spaces) 

19 35 C Beneficiary name 
54 10 C Beneficiary address 
64 1  Space 
65 2 N Model of Debit reference 
67 22 C Debit reference 
89 36 C Payment details 
125 6  Spaces 
131 1 C Deal value type (A, B, M, S) Bank of Slovenia, 

stat. Code; 
132 2 C Debit statistic code EX. : A3011 
134 2 C Credit statistic code  
136 13 N Amount  

E.g.: 2546400 = 25.464,00 

149 2 N Model of Credit reference 
151 22 C Credit reference 
173 6 D Valuation date  (DDMMYY) 
179 1 N Document type  

1 - payment order BN01, 2 - NOT in USE , 3 - 
special payment order “posebna položnica”, 4 - 
compensation 

180 1 N Sentence type  (1 – individual sentence) 
181 2 C Line brake (0x0D, 0x0A) 

  File ends with symbol 0x1A. 

18.1.2 Payment orders - import 

Imported orders should be in format, which is described in previous 
chapter. 

In E-Bank you can import payment orders prepared by instruction for 
presentation and take over information from payment instruction and 
statement about transactions and balance in computer form published in 
Uradni list RS št. 56/2002 and you can find it on the web: 
http://objave.uradnilist.si/bazeul/URED/2002/056/B/5227712312.htm.  

18.1.3 Transactions and statement 

Size of line file for export transactions and statement is : 

Position Length Type Contents 
1 18 N Partner’s account (debit or credit – depends of 

transaction type) 
1 5  Partner’s bank code and organization unit   

E.g.: 24302 
6 10  Partner’s account number 

E.g.: 9004674293 
16 3  Empty (spaces) 

19 2 C Source of information (booking mark 1x, 2x) 
21 8 D Processing date - booking date (DD.MM.LL) 
29 2 C Transaction reversal  (S)  (NLB – empty) 
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31 35 C Ordering party name 
66 1 C Method of payment 
67 6 D Valuation date (DDMMLL) 
73 18 N Ordering party account number 

73 5  Bank code and organization unit 
E.g.: 02241 

78 10  Ordering party account number 
E.g.: 0015771808 

88 3  Empty (Space) 

91 15 N Amount  
E.g.: 88018 = 880,18 

106 1  Empty (Space) 
107 1 C Deal value type (A, B, M, S) 
108 2 C Debit statistic code  

      110 2 C Credit statistic code 
112 2 N Model of Debit reference 
114 22 C Debit reference  
136 2 N Model of Credit reference  
138 22 C Credit reference 
160 36 C Payment details 
196 10 C Beneficiary address 
206 35 C Beneficiary name  
241 22 C Complaint number (transaction mark)  
263 18  Empty (Space) 
281 2 C Line brake (0x0D, 0x0A) 

  File ends with symbol 0x1A. 

18.1.4 Statement recapitulation  

Format of line file for export recapitulation statement is:  

Position Length Type Contents 
1 2 N Type of sentence: (01 – account balance) 
3 18 N Ordering party account number 

3 5  Bank code and organization unit 
E.g.: 02241 

8 10  Ordering party account number 
E.g: 0015771808 

18 3  Empty (space) 

21 8 D Process date - booking date (DD.MM.LLLL) 
29 8 D Previous statement date (DD.MM.LLLL) 
37 18 N Previous statement balance 
55 6 N Number of debit transactions 
61 18 N Sum of debit transactions per day 
79 6 N Number of credit transactions 
85 18 N Sum of credit transactions per day 
103 18 N Closing balance 
121 6 N Number of transactions in waiting row per day 
127 18 N Summary amount in waiting row per day 
145 3 N Statement number  
148 2 C Line brake (0x0D, 0x0A) 

  File ends with symbol 0x1A. 

18.1.5 File of beneficiary accounts 

File in every row contains information about business partner and one 
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of his accounts. In the frame is shown example of texture file to enter the 
business partner names (In the frame is one row, which is because of the 
big length shown in several rows): 

"HALCOM INFORMATIKA D.O.O.","TRŽAŠKA 118","1000 LJUBLJANA", 
"SLOVENIJA","","50102-601-000-0124580","","","","","","", 
"00100-50005","" 

 

Row format description:  

• Each row contains 14 fields / columns,  

• Contents of each field cling pair of double inverted commas, 

• Punctuation marks between fields are commas, 

• Empty fields are presented with two sequence quotation marks  
(""), 

• Row ends with sign 0x0D and 0x0A. 

Comment: double inverted commas within field present two, 
quotation marks. For example "TO JE """ imported as TO JE “. 

Information is divided in three complexes. Fields from one to including 
five contain information about beneficiary, fields six and thirteen contains 
information about account, model and beneficiary, fields from seven to 
twelve and field fourteen and information about bank where account is 
opened. Information about bank at home accounts imports replaced with 
information from bank nominal list. In the fields six and thirteen are 
allowed only signs numbers and hyphen -. 

 Comment: Information model of nominal list is created like that, that 
enables presentation of information about beneficiary               
accounts from outside banks, which E-bank for domestic payment               
don’t use.  

Table shows meaning and largest allowed width fields. If the field six (account 
number) is empty, than you enter only information about beneficiary. 

 

Field 
number 

The largest 
width (signs) 

Mandatory Contents 

1 35 * Last name and first name  

2 35  Address 

3 35 * Post code 

4 35 * Country 

5 140  Comment 

6 34  Account number in APP or TRR 
format 

7 35  Bank name 

8 35  Bank address 

9 35  Post number 

10 35  Country of bank 



162 

11 140  Comment about bank 

12 11  Bank BIC code 

13 24  Model of debit reference and 
Debit reference 

14 35  Bank number 

 
 
 

18.2 Reports about software errors 
Report software error to your contact person. To report software errors 

collect the following information. You report information to the person 
indicated in the bank agreement, or through message in Hal E-Bank 
program. 

18.2.1 Contact information 

Send the following information about yourself and the system you are 
using: 

• name and surname, 

• name of the company, 

• the address of the company, 

• postal code and town, 

• telephone number,  

• fax number  and 

• e-mail. 

18.2.2 Description of the problem 

When you are describing the problem that you have encountered while 
using the Hal E-Bank program, report the following information: 

• version of Hal E-Bank, 

• type of your computer, 

• type of the operating system (for example Windows 95/98, 2000, 
XP), 

• type of the connection with a bank server (modem, LAN), 

• the error message given by the program, 

• steps that you performed that led to the error; 

• the list of actions you already had executed. 
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18.2.3 Additional information 

In additional information that is connected to the communication problem, 
please state: 

• the type of communication and connection of your computer 
(modem, LAN...), 

• computers on which the problem is encountered, 

• all recent changes and upgrading done to the computers  

• connected equipment, 

• contents of the TCP/IP configuration. 

18.3 Copyright information 
Microsoft, Windows 95/98/2000/XP/2003 and Windows NT are registered 

trade-marks of Microsoft Corporation. IBM DB2 is a trademark of 
International Business Machines Corporation. 

Hal E-Bank/Personal, Hal E-Bank/Corporate, Hal E-Bank/Web, Hal E-
Bank/SMS, Hal E-Bank/B2B and Hal E-Bank/B2B Channel, are trademarks 
of Halcom Informatika d.o.o., Slovenia. 
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